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The above warning is located on the rear of the unit.

Explanation of Graphical Symbols
The lightning flash with arrowhead symbol 
within an equilateral triangle is intended to alert 
the user to the presence of uninsulated 
“dangerous voltage” within the product’s 
enclosure that may be of sufficient magnitude to 
constitute a risk of electric shock to persons.

The exclamation point within an equilateral 
triangle is intended to alert the user to the 
presence of important operating and 
maintenance (servicing) instructions in the 
literature accompanying the product.

IMPORTANT SAFETY INSTRUCTIONS
1 Read these instructions.
2 Keep these instructions.
3 Heed all warnings.
4 Follow all instructions.
5 Do not use this apparatus near water.
6 Clean only with dry cloth.
7 Do not block any ventilation openings. Install in 

accordance with the manufacturer’s instructions.
8 Do not install near any heat sources such as radiators, 

heat registers, stoves, or other apparatus (including 
amplifiers) that produce heat.

9 Do not defeat the safety purpose of the polarized or 
grounding-type plug. A polarized plug has two blades 
with one wider than the other. A grounding type plug 
has two blades and a third grounding prong. The wide 
blade or the third prong are provided for your safety. If 
the provided plug does not fit into your outlet, consult 
an electrician for replacement of the obsolete outlet.

10 Protect the power cord from being walked on or pinched 
particularly at plugs, convenience receptacles, and the 
point where they exit from the apparatus.

11 Only use attachments/accessories specified by the 
manufacturer.

12 Use only with the cart, stand, 
tripod, bracket, or table specified 
by the manufacturer, or sold with 
the apparatus. When a cart is 
used, use caution when moving 
the cart/apparatus combination 
to avoid injury from tip-over.

13 Unplug this apparatus during 
lightning storms or when unused for long periods of 
time.

14 Refer all servicing to qualified service personnel. 
Servicing is required when the apparatus has been 
damaged in any way, such as power-supply cord or plug 
is damaged, liquid has been spilled or objects have 
fallen into the apparatus, the apparatus has been 
exposed to rain or moisture, does not operate normally, 
or has been dropped.

(98-6500)

CAUTION: TO REDUCE THE RISK OF 
ELECTRIC SHOCK, DO NOT REMOVE 

COVER (OR BACK). NO USER-SERVICEABLE 
PARTS INSIDE. REFER SERVICING TO 

QUALIFIED SERVICE PERSONNEL.

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

WARNING
TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE.



                         

*

    
1. IMPORTANT NOTICE: DO NOT MODIFY THIS UNIT!
This product, when installed as indicated in the instructions con-
tained in this manual, meets FCC requirements. Modifications not 
expressly approved by Yamaha may void your authority, granted by 
the FCC, to use the product.

2. IMPORTANT: When connecting this product to accessories and/
or another product use only high quality shielded cables. Cable/s 
supplied with this product MUST be used. Follow all installation 
instructions. Failure to follow instructions could void your FCC 
authorization to use this product in the USA.

3. NOTE: This product has been tested and found to comply with the 
requirements listed in FCC Regulations, Part 15 for Class “B” digital 
devices. Compliance with these requirements provides a reason-
able level of assurance that your use of this product in a residential 
environment will not result in harmful interference with other elec-
tronic devices. This equipment generates/uses radio frequencies 
and, if not installed and used according to the instructions found in 
the users manual, may cause interference harmful to the operation 
of other electronic devices. Compliance with FCC regulations does 

his applies only to products distributed by YAMAHA CORPORATION OF AMERICA. (class B

not guarantee that interference will not occur in all installations. If 
this product is found to be the source of interference, which can be 
determined by turning the unit “OFF” and “ON”, please try to elimi-
nate the problem by using one of the following measures:
Relocate either this product or the device that is being affected by 
the interference. 
Utilize power outlets that are on different branch (circuit breaker or 
fuse) circuits or install AC line filter/s.
In the case of radio or TV interference, relocate/reorient the 
antenna. If the antenna lead-in is 300 ohm ribbon lead, change the 
lead-in to co-axial type cable.
If these corrective measures do not produce satisfactory results, 
please contact the local retailer authorized to distribute this type of 
product. If you can not locate the appropriate retailer, please con-
tact Yamaha Corporation of America, Electronic Service Division, 
6600 Orangethorpe Ave, Buena Park, CA90620
The above statements apply ONLY to those products distributed by 
Yamaha Corporation of America or its subsidiaries.

FCC INFORMATION (U.S.A.)

The serial number of this product may be found on the rear of 
the unit. You should note this serial number in the space pro-
vided below and retain this manual as a permanent record of 
your purchase to aid identification in the event of theft.

Model No. 

Serial No.

(rear)

* This applies only to products distributed by 
YAMAHA CORPORATION OF AMERICA.

COMPLIANCE INFORMATION STATEMENT
(DECLARATION OF CONFORMITY PROCEDURE)

Responsible Party : Yamaha Corporation of America
Address : 6600 Orangethorpe Ave., Buena Park, Calif. 90620

Telephone : 714-522-9011
Type of Equipment : Digital Mixing Studio

Model Name : n8/n12

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received including interference 

that may cause undesired operation.
See user manual instructions if interference to radio reception is suspected.

(FCC DoC

OBSERVERA!
Apparaten kopplas inte ur växelströmskällan (nätet) så länge 
som den ar ansluten till vägguttaget, även om själva apparaten 
har stängts av.

ADVARSEL: Netspæendingen til dette apparat er IKKE 
afbrudt, sålæenge netledningen siddr i en stikkontakt, som er t 
endt — også selvom der or slukket på apparatets afbryder.

VAROITUS: Laitteen toisiopiiriin kytketty käyttökytkin ei irroita 
koko laitetta verkosta.

(standby)

IMPORTANT
Please record the serial number of this unit in the space below.
Model:

Serial No.:

The serial number is located on the bottom or rear of the unit.
Retain this Owner's Manual in a safe place for future 
reference.

(Ser. No)This applies only to products distributed by 
YAMAHA CORPORATION OF AMERICA

IMPORTANT NOTICE FOR THE UNITED KINGDOM
Connecting the Plug and Cord

IMPORTANT.  The wires in this mains lead are coloured in accordance 
with the following code:

BLUE   :  NEUTRAL
BROWN :  LIVE

As the colours of the wires in the mains lead of this apparatus may not 
correspond with the coloured makings identifying the terminals in your 
plug proceed as follows:
The wire which is coloured BLUE must be connected to the terminal 
which is marked with the letter N or coloured BLACK.
The wire which is coloured BROWN must be connected to the termi-
nal which is marked with the letter L or coloured RED.
Making sure that neither core is connected to the earth terminal of the 
three pin plug.

• This applies only to products distributed by Yamaha-Kemble Music (U.K.) Ltd. (2 wires)
* T )
)
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Thank you for purchasing the Yamaha n8/n12 Digital Mixing Studio. The n8/n12 is a comprehensive music production system 
that packages a digital mixer featuring easy yet full-fledged recording/mixdown operations with the cutting-edge DAW software 
Cubase AI4. Connecting a computer to the mixer’s IEEE 1394 port enables you to configure an ideal recording environment.
Please read this Owner’s Manual before you start using the n8/n12 so that you can take full advantage of the mixer’s superlative 
features and enjoy trouble-free operation for years to come. Also, keep this book in a safe place for future reference.

 

Ease of operation

 

Analog-like mixing interface ensures intuitive operation.

 

High-quality sound

 

Based on an examination of existing head amp circuits, a new head amp circuit has been developed to provide higher 
quality and superior musical characteristics.

 

Mixer functions

 

The mixer can handle up to 16 channel inputs (n12) or 12 channel inputs (n8), mixing them to stereo outputs. Each 
monaural input jack features an XLR jack with a phantom power supply, which enables you to connect a wide range of 
instruments and devices, from condenser microphones to synthesizers and other line-level instruments. Input channel 8 
(n12) and Input channel 4 (n8) support Hi-Z input for direct connection of an electric guitar or bass.

 

Computer connection via a single IEEE 1394 cable

 

Connect a computer with an IEEE 1394 port to the n8/n12 using an IEEE 1394 cable to transfer audio and MIDI signals 
between the mixer and Steinberg Cubase or other DAW.

 

* In order to monitor in a surround environment, you will need a surround-capable application such as Cubase 4. The included 
Cubase AI4 does not support surround.

 

Link with Cubase

 

Install Cubase AI4 on the computer, and the n8/n12 will link to Cubase and operate together seamlessly. For example, you 
can record the n8/n12 input signals to Cubase as is, or mix Cubase audio tracks on the n8/n12. You can also turn on and 
off the monitor for the VST effects or control the transport section and tracks remotely from the n8/n12. In addition, Purchase 
the separately-available Cubase 4 and use it with the n8/n12 to enjoy advanced functionality such as surround.

 

Control Room monitoring function

 

The n8/n12 features a monitoring function dedicated to the Control Room (Control Room Monitor function). You can 
connect one (n8) or three (n12) monitoring speakers to the mixer. If a computer is connected to the n12, you can 
monitor the sound from Cubase or another DAW in a surround sound environment.

 

Newly developed compressor

 

The n8/n12 includes a newly developed compressor that adopts Sweet Spot Morphing technology. The mixer provides 
various compressor presets that represent the distillation of extensive professional engineering experience, letting you 
quickly and easily bring your sound to a professional standard.

 

Three-band EQ on each channel

 

Each input channel features a full 3-band (high/mid/low) equalizer, providing easy sound shaping to suit your preferences.

 

Digital reverb at your service

 

A built-in digital reverb can be assigned to all input channels. If a computer is connected to the mixer, you can also apply 
digital reverberation to output from Cubase or another DAW, as well as to microphone and other instrumental sounds.

Power adaptor (n12= PA-30, n8=PA-20)*
* May not be included depending on your particular 

area. Please check with your Yamaha dealer.
Owner’s Manual
IEEE 1394 cable
TOOLS for n/Cubase AI4 installation guide

TOOLS for n CD-ROM
Cubase AI4 DVD-ROM
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Please read the software license agreement before 
you unseal the included discs. The software license 
agreement is given at the end of the TOOLS for n/
Cubase AI4 installation guide.
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PRECAUTIONS
PLEASE READ CAREFULLY BEFORE PROCEEDING 

* Please keep this manual in a safe place for future reference.

 WARNING
Always follow the basic precautions listed below to avoid the possibility of serious injury or even death from electrical 
shock, short-circuiting, damages, fire or other hazards. These precautions include, but are not limited to, the following:

• Only use the voltage specified as correct for the device. The required voltage is 
printed on the name plate of the device.

• Use only the included AC power adaptor (*PA-30 for the n12, PA-20 for the n8 
or an equivalent recommended by Yamaha). 

• Do not place the power cord near heat sources such as heaters or radiators, 
and do not excessively bend or otherwise damage the cord, place heavy objects 
on it, or place it in a position where anyone could walk on, trip over, or roll 
anything over it.

• Do not open the device or attempt to disassemble the internal parts or modify 
them in any way. The device contains no user-serviceable parts. If it should 
appear to be malfunctioning, discontinue use immediately and have it 
inspected by qualified Yamaha service personnel.

• Do not expose the device to rain, use it near water or in damp or wet 
conditions, or place containers on it containing liquids which might spill into 
any openings.
If any liquid such as water seeps into the device, turn off the power immediately 
and unplug the power cord from the AC outlet. Then have the device inspected 
by qualified Yamaha service personnel.

• Never insert or remove an electric plug with wet hands.

• If the power cord or plug becomes frayed or damaged, or if there is a sudden 
loss of sound during use of the device, or if any unusual smells or smoke 
should appear to be caused by it, immediately turn off the power switch, 
disconnect the electric plug from the outlet, and have the device inspected by 
qualified Yamaha service personnel.

• If this device or the AC power adaptor should be dropped or damaged, 
immediately turn off the power switch, disconnect the electric plug from the 
outlet, and have the device inspected by qualified Yamaha service personnel.

 CAUTION
Always follow the basic precautions listed below to avoid the possibility of physical injury to you or others, or damage 
to the device or other property. These precautions include, but are not limited to, the following:

• Remove the electric plug from the outlet when the device is not to be used for 
extended periods of time, or during electrical storms.

• When removing the electric plug from the device or an outlet, always hold the 
plug itself and not the cord. Pulling by the cord can damage it.

• To avoid generating unwanted noise, make sure there is adequate distance 
between the AC power adaptor and the device.

• Do not cover or wrap the AC power adaptor with a cloth or blanket.

• Before moving the device, remove all connected cables.
• When setting up the device, make sure that the AC outlet you are using is easily 

accessible. If some trouble or malfunction occurs, immediately turn off the 
power switch and disconnect the plug from the outlet. Even when the power 
switch is turned off, electricity is still flowing to the product at the minimum 
level. When you are not using the product for a long time, make sure to unplug 
the power cord from the wall AC outlet. 

• Avoid setting all equalizer controls and faders to their maximum. Depending on 
the condition of the connected devices, doing so may cause feedback and may 
damage the speakers.

• Do not expose the device to excessive dust or vibrations, or extreme cold or 
heat (such as in direct sunlight, near a heater, or in a car during the day) to 
prevent the possibility of panel disfiguration or damage to the internal 
components.

• Do not place the device in an unstable position where it might accidentally fall 
over.

• Do not block the vents. This device has ventilation holes at the top/bottom to 
prevent the internal temperature from becoming too high. In particular, do not 
place the device on its side or upside down. Inadequate ventilation can result in 
overheating, possibly causing damage to the device(s), or even fire.

• Do not use the device in the vicinity of a TV, radio, stereo equipment, mobile 
phone, or other electric devices. Doing so may result in noise, both in the 
device itself and in the TV or radio next to it.

• Before connecting the device to other devices, turn off the power for all devices. 
Before turning the power on or off for all devices, set all volume levels to 
minimum.

Power supply/Power cord

Do not open

Water warning

If you notice any abnormality

Power supply/Power cord

Location

Connections
Owner’s Manual
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• Remove the power plug from the AC outlet when cleaning the device.

• When turning on the AC power in your audio system, always turn on the power 
amplifier LAST, to avoid speaker damage. When turning the power off, the 
power amplifier should be turned off FIRST for the same reason.

• Do not insert your fingers or hands in any gaps or openings on the device 
(vents, ports, etc.).

• Avoid inserting or dropping foreign objects (paper, plastic, metal, etc.) into any 
gaps or openings on the device (vents, ports, etc.) If this happens, turn off the 
power immediately and unplug the power cord from the AC outlet. Then have 
the device inspected by qualified Yamaha service personnel.

• Do not apply oil, grease, or contact cleaner to the faders. Doing so may cause 
problems with electrical contact or fader motion.

• Do not use the device or headphones for a long period of time at a high or 
uncomfortable volume level, since this can cause permanent hearing loss. If 
you experience any hearing loss or ringing in the ears, consult a physician.

• Do not rest your weight on the device or place heavy objects on it, and avoid 
use excessive force on the buttons, switches or connectors.

Always turn the power off when the device is not in use. 

Even when the power switch is in the “STANDBY” position, electricity is still flowing to the device at the minimum level. When you are not using the device for a long time, 
make sure you unplug the power cord from the wall AC outlet.

The performance of components with moving contacts, such as switches, volume controls, and connectors, deteriorates over time. Consult qualified Yamaha service 
personnel about replacing defective components.

The illustrations and LCD screens as shown in this owner’s manual are for instructional purposes only, and may appear somewhat different from those on your instrument.

This product incorporates and bundles computer programs and contents in which Yamaha owns copyrights or with respect to which it has license to use others' copyrights.  
Such copyrighted materials include, without limitation, all computer software, music data, etc. Any unauthorized use of such programs and contents outside of personal use 
is not permitted under relevant laws.  Any violation of copyright has legal consequences.  DON'T MAKE, DISTRIBUTE OR USE ILLEGAL COPIES.

Copying of the commercially available musical data including but not limited to MIDI data and/or audio data is strictly prohibited except for your personal use.

• Windows is the registered trademarks of Microsoft(R) Corporation.

• Apple, Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries.

• FireWire and the FireWire symbol are trademarks of Apple, Inc., registered in the U.S. and other countries. The FireWire logo is a trademark of Apple, Inc.

• Steinberg and Cubase are the registered trademarks of Steinberg Media Technologies GmbH.

• The company names and product names in this Owner’s Manual are the trademarks or registered trademarks of their respective companies.

Maintenance

Handling caution

XLR-type connectors are wired as follows (IEC60268 standard): pin 1: ground, pin 2: hot (+), and pin 3: cold (-).

Insert TRS phone jacks are wired as follows: sleeve: ground, tip: send, and ring: return.

Yamaha cannot be held responsible for damage caused by improper use or modifications to the device, or data that is lost or destroyed.
Owner’s Manual 7
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Before Turning On the 

 

Power to the Mixer

 

1.

 

Make sure that the mixer’s power switch is in the 
STANDBY position.

 

2.

 

Connect the power adaptor to the AC INPUT 
connector (1

 

) on the rear panel of the mixer, 
then turn the fastening ring clockwise (2

 

) to 
secure the connection.

 

3.

 

Connect the power adaptor to a standard 
household power outlet securely.

 

Turning the Power On and 

 

Off

 

1.

 

To turn the power on, press the mixer’s power 
switch to the ON position.

 

2.

 

To turn the power off, press the power switch to 
the STANDBY position.

 

Turning On and Off the Power to the Mixer

 

Warning

 

Use only the included power adaptor (*PA-30 for the n12, PA-
20 for the n8 or an equivalent recommended by Yamaha). Use 
of a different adaptor may result in equipment damage, 
overheating, or fire. In such cases, the product warranty will be 
void immediately even within the effective warranty period.

 

Caution

 

• Be sure to unplug the adaptor from the outlet when you are 
not using the mixer, or when lightning storms are expected in 
your area.

• Make sure that there is adequate distance between the 
power adaptor and the mixer. Otherwise, noise may be 
generated.

2

1

 

Caution

 

Note that a small amount of current continues to flow while the 
switch is in the STANDBY position. If you do not plan to use the 
mixer for an extended period of time, please be sure to unplug 
the adaptor from the wall outlet.

To prevent sudden loud sounds from being 
produced from your speakers, power-on your 
equipment starting at the audio source (instrument, 
mic, CD player, etc.) and working downstream.

 

Example:

 

 Instruments, mics, CD players, and other 
peripheral devices 

 

→

 

 n8/n12 

 

→

 

 Powered speakers 
(power amps)
When turning the power off, reverse the above 
sequence.

NOTE
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Techie Words? Don’t Be Afraid.

Signals — Level and Decibel
Assume the softest sound a human being can hear is at 
a level of “1,” and the loudest sound a human being can 
endure hearing is at a level of “1,000,000.” The 
difference expressed in these numbers is huge, and 
you have to use too many digits to express the level. 
This is very inconvenient. So, we use a term or unit 
called “decibel (dB),” defining the normal level 
difference between the softest and loudest sounds 
detectable by human hearing to be 120 dB.
A decibel is a relative value based on a reference level 
of 0 dB. Audio devices usually treat audio as electrical 
signals. There are various types of decibel 
measurements: dBu, dBV, dBm, etc., but the most 
popular one is dBu, which is based on 0.775V as the 
reference level (0 dBu). The output level of a 
microphone is very low –– about several millivolts (–60 
dBu — –30 dBu). On the other hand, the maximum 
output of a mixer can be 12 V (+24 dBu).

To create clear sounds, a signal should be input to a 
mixer at an appropriate level. When you connect audio 
devices to your mixer, be sure to match the nominal 
input of an instrument to the output level of the mixer, 
then adjust the input level with the mixer’s gain control. 

Balanced or Unbalanced?
In most cases, shielded cables are used to transfer 
signals between audio devices. Shielded cables are 
divided into two types: balanced and unbalanced.
Balanced lines are very good at rejecting noise, and 
they are the best choice for long cable runs or for 
transferring very weak signals. Unbalanced cables are 
usually used for line-level signals.

Microphone: Use balanced lines.
Short line-level runs: Unbalanced lines are fine.
Long line-level runs: Use balanced lines.

We are constantly surrounded by random electromagnetic 
radiation (noise), such as radio and TV signals as well as 
spurious electromagnetic noise generated by power lines, 
motors, electric appliances, computers, and other 
sources. The longer the wire, the more noise it is likely to 
pick up. To avoid noise, use the shortest cable possible.

How balanced lines work
A cable that features an XLR plug on each end is a 
balanced line. It consists of hot (+), cold (–), and 
ground conductors.
A device transmits an original hot (+) signal through the 
hot conductor and the same, but inverted, signal 
through the cool (–) conductor to the destination. The 
receiving device inverts the inverted signal back to 
normal and combines it with the original hot signal.
Any noise induced in the line will be exactly the same in 
both conductors, and thus in phase. The trick is that the 
phase of one signal (through the cool (–) conductor) is 
reversed at the receiving end of the line so that the 
desired audio signals become in-phase, and the 
induced noise suddenly finds itself out of phase. The 
out-of-phase noise signal is effectively canceled while 
the audio signal is left intact.

Recording Basics

+ 20 dBu

0 dBu0.775 V

-20 dBu

-40 dBu

-60 dBu

Professional audio gear, such as a 
mixer or a power amplifier, features 
line inputs and outputs with a 
nominal level of +4 dBu.

Keyboards and other line instruments 
have line inputs and outputs with a 
nominal level of –10 dBu.

Microphone levels vary depending 
on the sound source. Speech is at 
about –30 dBu. Bird chirping is 
lower than –50 dBu. Closely 
recorded drums could reach 0 dBu.

input signal

gain
control output signal

too high

appropriate
level

too low

Anatomy of a shielded cable

As shown in the illustration above, a shielded cable 
consists of one hot (and cold conductor) wrapped in a 
metal net (shield, or ground conductor). The ground 
functions as a barrier against noise, protecting the 
signal from noise that may be induced in the line.

hot
cold

shield 
(ground)

jacket

balanced unbalanced
Owner’s Manual 9
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This is why balanced lines excel at rejecting noise.

How unbalanced lines work
Unbalanced connectors and cables are less expensive 
than balanced cables. If the level of signals to be 
transmitted is very high and/or the signal is not 
susceptible to noise, or all connections are very short, 
you can use unbalanced lines.
Monaural phone jacks and RCA pin jacks (which are 
often used for consumer AV gear) are always 
unbalanced. On an unbalanced line, signals travel 
through a hot (+) conductor and a ground (GND) 
conductor (which is a combination of cold and ground 
conductors). Therefore, an unbalanced line does not 
feature noise canceling (unlike a balanced cable). 
However, the output signal level through unbalanced 
jacks is usually high enough that using unbalanced 
lines is just fine. You can also convert unbalanced 
signals into balanced signals using a DI (*).

(*)A DI is a direct injection box that converts unbalanced 
signals into balanced signals. For example, if you 
connect an electric guitar to a mixer directly, the sound 
may be thin or noise may be induced. In this case, you 
can connect a DI between the instrument and the 
mixer to convert the signal into a balanced one and 
avoid a thin, noisy sound.

Connector Variations
Audio devices feature various types of connectors. 
Questions you are likely to encounter when setting up a 
system for the first time might include “Why all these 
different types of connectors on the back of my mixer?” 
and “What is the difference between various types of 
connectors?”
Let’s start by taking a look at the most common types of 
connectors.

XLR-type connectors

An XLR-type connector, which supports balanced lines, 
is sturdy and less susceptible to deformation. The plug 
features a lock mechanism, so even if you pull the 
cable, it will not be disconnected. It is often used in 
professional environments that demand a high level of 
reliability.
When you connect an XLR cable, the ground conductor 
on the XLR plug and XLR jack comes in contact first. 
Therefore, unlike with an RCA pin cable or phone cable, 
you can avoid pop noises when connecting an XLR 
cable. Usually, male plugs will output and female plugs 
will input. 

Phone connectors

The name “phone” arose simply because this 
configuration was first used in telephone switchboards. 
Phone jacks can be stereo or monaural. A stereo phone 
jack is also referred to as a “TRS” phone jack, and is set 
up to handle stereo signals, such as for headphones, 
and insert I/O signals. A stereo phone jack can also 
handle balanced signals. A monaural phone jack is 
unbalanced, and can be used to connect an electric 
guitar or other instruments, to an amplifier.

RCA pin connectors

This type of unbalanced pin jack has been widely used 
on home audio/video equipment for many years. The 
plugs are color coded according to the signals they 
carry. A white plug is used for the left audio channel, 
and a red plug is used for the right audio channel.

noise

hot (+)

cold (–)

ground 
(GND)

transmitter cable receiver

noise canceling

phase 
inversion phase 

inversion

synthesized 
signal

noise

transmitter cable receiver

male female

stereo/TRS phone plug mono phone plug

white

red
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Inside Your Mixer

Basic Structure
The purpose of configuring an audio system around a 
mixer is to collect signals from all channels and mix to 
achieve a good balance. Here is a greatly simplified 
block diagram of a mixer to help you understand the 
signal path.

Simplified mixer block diagram

■ Input channel
1 Head amp

The very first stage in any mixer through which the 
input signal flows. The head amp features a gain 
control that enables you to adjust the mixer’s input 
sensitivity to match the level of the source.
You can amplify small signals, and attenuate large 
signals.

2 Compressor/Equalizer
This stage enables you to process the input signal.
A compressor attenuates the peak level of the input 
signal, and raises the overall signal level at the same 
time, to lessen the level difference and raise the 
sound pressure.
An equalizer adjusts the tone by boosting 
(amplifying) or cutting (attenuating) certain 
frequency ranges. You can use an equalizer to 
change the tone to suit the acoustic environment of 
a particular room, or to create a new sound. An 
equalizer could be a high pass filter that cuts the 
sound below a specified frequency.
Some mixers feature compressors and/or equalizers, 
and some do not.

3 Level meter (input channel)
If the signal level is too high for the head amp or 
compressor/equalizer to handle, the sound will clip 
and be distorted. An input channel level meter enables 
you to monitor this signal level. Some mixers feature a 
channel peak LED that indicates only the peak level.
If the input signal is overloaded, adjust the head 
amp gain control.
Most mixers have multiple level meters (including the 
indicators). It is important to know the mixer stage for 
which the meters are indicating signal levels.

4 Channel fader
A channel fader enables you to adjust the level of 
the corresponding input channel signal that is going 
to be routed to the buses (excluding a pre-fader 
signal).
This control is most often used during mixing.

■ Bus
5 Bus

Input channel signals are routed to buses, mixed 
together there, then output in stereo (master).

Buses are categorized into a few types based on their 
purpose: stereo bus for stereo mix, AUX bus for AUX 
send, etc. Using the appropriate buses is one of the 
keys to basic mixing.

The n8/n12 features the following buses:
• STEREO bus (L/R)
• AUX bus (L/R)
• REC bus (L/R)
• REVERB bus (L/R)
• SOLO bus (L/R)

■ Master section
6 Stereo (master) fader

The master section enables you to adjust the level of 
signals routed from buses.
Use a stereo master fader to adjust the level of the 
mixer’s main output from the stereo buses. 
Depending on the design of the mixer, a fader is 
provided for each bus so that you can adjust the 
level of each bus output.

7 Level meter (master)
This meter indicates the signal level in the master 
section, which is the mixer’s final output level.

IN

OUT

B
U

S

1 2 3 4 5 6 7

COMP EQ

input channel bus
master 
section

bus
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Monitor mix for musicians, 
external effects
One important mixer function is to send out signals for 
signal processing via an external effect unit or to be 
monitored by the musicians. For these purposes, mixers 
feature AUX bus and Insert I/O.

■ AUX buses for monitor sends 
and overall effects

AUX (Auxiliary) buses are very convenient buses that 
can be used for various purposes, such as: a) to create 
a monitor mix that is separate from the main mix and 
sent to the players for monitoring, and b) to process the 
signal via an external effect unit and then bring it back 
into the mix.
When you are using the AUX buses, you need to 
consider whether you want a “pre-fader” signal (a signal 
taken from a point before the channel fader) or a “post-
fader” signal (a signal taken from a point after the 
channel fader) to be sent to the AUX buses.
On the n8/n12, a pre-fader signal is sent to the AUX 
bus. Thus the bus signal is not affected by the channel 
fader.

• Using AUX buses to create a monitor mix for players
Players prefer a pre-fader signal that maintains a proper 
level balance. Since the pre-fader signal is sent to the 
AUX bus on the n8/n12, even if you raise the input 
channel fader for guitar during the guitar solo, the fader 
operation does not affect the AUX bus output, which 
remains independent of the main mix.
If a post-fader signal is routed to the AUX buses for 
monitoring, the fader operation will affect the balance of 
the monitor mix. This is something that you and the 
players would probably like to avoid.

• Using AUX buses to process the signal via an 
external effect unit

If you are using an AUX bus to send a pre-fader signal 
to an external effect unit, you can adjust the level of the 
input channel signal and the amount of effect 
separately.
For example, if you operate the fader for the input 
channel signal that is sent to the effect unit, the balance 
between the dry signal (unprocessed) and the wet 
signal (processed by the effect unit) will change. To 
maintain the same balance between the dry and wet 
signals, you must adjust the AUX send level whenever 
you adjust the channel fader.

■ Insert I/O for processing 
individual channel signals

Insert I/O jacks function in a manner similar to the AUX 
buses: they provide a send and a return for signal 
processing via an external effect unit. However, unlike 
AUX buses that “collect multiple channel signals, then 
send them together to an effect unit,” insert I/O jacks 
are used to “send an individual channel signal to an 
external effect unit, then return it to the mixer.”
A channel signal that is routed to the insert out jack has 
already been amplified or attenuated to an appropriate 
level via the gain control. Connect a compressor, limiter, 
equalizer or other effect unit that can control the overall 
signal to the insert I/O jacks.
You can also connect a reverb or similar effect unit to 
process only a single channel signal.
When you connect an effect unit to the insert I/O jacks, 
the channel signal will be routed to the external effect 
unit via the insert out jack. The signal will be processed 
by the effect unit, then returned to the mixer via the 
insert in jack. It then resumes its normal path.

PRE ON

OUT

OUT

A
U

X 
B

U
S

ST
ER

EO
 B

U
S

channel 
fader

stereo fader

AUX send level

■ Built-in digital reverb
The n8/n12 features a REVERB bus that is dedicated 
to the built-in digital reverb. This is almost identical to 
the AUX bus, and can be used to send signals to the 
built-in digital reverb.
The only difference from the AUX bus is that a post-
fader signal is routed to the REVERB bus. Therefore, 
the send level is affected by the channel fader, so 
the effect level always remains in proportion to the 
channel signal when you adjust the channel fader.
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R
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B
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S
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channel fader
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REVERB 
send level

digital 
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INPUT CHANNEL
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effect unit
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Owner’s Manual

Channel Control section

1 [GAIN] control
This control adjusts the input signal level from the input 
jacks (sensitivity). The adjustable range on each 
monaural channel varies depending on the on/off status 
of the [PAD] switch (2).

To achieve a quality sound with a good S/N ratio and 
a wide dynamic range, set this control as high as 
possible without allowing the OVER LED (see 
page 15) to light.

2 [PAD] switch
This switch turns each channel pad on and off. 
When it is turned on ( ), the input signal from the 
input jacks is attenuated by 26 dB. Turn the switch 
off ( ) when you connect a microphone or other 
device with a low input level to the corresponding 
monaural channel. Turn it on ( ) when you 
connect a synthesizer or other line-level instruments.

3 switch (high pass filter)
This switch toggles the high pass filter on or off. 
When the switch is turned on ( ), the high pass 
filter cuts frequencies below 80 Hz of the signal from 
the input jacks.

4 PHANTOM [+48V] switch
This switch toggles phantom power for condenser 
microphones on and off. If you are connecting 
condenser microphones to the XLR-type INPUT A 
jacks on the rear panel, turn the switch on ( ). 
(The switch LED lights up.)
Each phantom switch turns the phantom power on and 
off for four channels simultaneously. (Channels 1-4 and 
channels 5-8 on the n12, and channels 1-4 on the n8).

Front and Rear Panels

)

!

1
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5 6
3
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n12

Monaural input channel

[PAD] switch is 
on ( ).

The level can be adjusted between 
–34 dB and +10 dB.

[PAD] switch is 
off ( ).

The level can be adjusted between 
–60 dB and –16 dB.

Stereo input channel

The level can be adjusted between –26 dB and +4 dB.

When the switch is turned on, phantom power DC 
+48V will be supplied to Pin 2 and Pin 3 of the 
corresponding XLR-type INPUT A jacks.

NOTE
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5 [PHASE] switch
Turning this switch on ( ) inverts the phase of the 
signal from the input jacks.
For more information on the [PHASE] switch, refer to 
“Tip for compensating for the phase offset” on 
page 15.

6 [Hi-Z] switch
If you are connecting an electric guitar or electric 
bass that has passive-type pickups and no built-in 
preamp directly to the INPUT B jack of input channel 
8 (on the n12) or input channel 4 (on the n8), turn 
this switch on ( ).

7 [INPUT SELECT] switch
This switch determines whether the input jack signal 
(A.IN) or the DAW signal (the output from Cubase or 
another DAW) will be routed to the input channels. 

8 Compressor controls
These compressor controls enable you to operate the 
compressor for each monaural input channel 
(channels 1-4 on the n8, and channels 1-8 on the n12).
The following two controls are available for each 
compressor: [MORPH] control and [DRIVE] control.

[MORPH] control
This control specifies the compressor setting. Knob 
positions A-E correspond to different presets. You 
can easily change the compressor setting by rotating 
the control. Knob positions between alphabetical 
settings will use an intermediate value taken from 
between two corresponding preset values.

[DRIVE] control
This control specifies the amount of compression. As 
you rotate the control clockwise, more compression 
is applied. The output level changes automatically 
as the amount of compression changes.

COMP LED
This LED lights up when the compressor is triggered.

9 Equalizer (EQ)
This three-band equalizer adjusts the input channel’s 
high, mid, and low frequency bands. You can also 
adjust the center frequency for the mid band.

[HIGH] gain control
This control adjusts the high band gain.

[MID] frequency control
This control adjusts the mid band center frequency.

[MID] gain control
This control adjusts the mid band gain.

[LOW] gain control
This control adjusts the low band gain.

Setting each gain control knob to the “▼” position 
produces a flat frequency response (no boost). 
Turning the knob clockwise boosts the 
corresponding frequency band, while turning 
counter-clockwise attenuates the band.
To raise the mid band center frequency, turn the 
[MID] frequency control clockwise. To lower the 
center frequency, turn the [MID] frequency control 
counter-clockwise. At the center position, the center 
frequency is 1.0 kHz.
The following table shows the EQ type, center frequency, 
and maximum cut/boost for each of the three bands.

) [REVERB] control
This control adjusts the level of the input channel 
signal sent to the internal digital reverb (i.e., 
determines how much reverb will be applied).
When you set the knob to the “▼” position, the input 
channel signal at the nominal level (0 dB) will be 
sent to the internal digital reverb.

! [AUX] control
This control adjusts the level of the input channel 
signal sent to the AUX bus. Use this control when 
you are sending a mix monitoring signal to the 
musicians, or sending the signal to an external 
device, such as an effects processor.

@ [PAN] and [BAL] controls

[PAN] control
This control determines the stereo position of the 
monaural input channel. Rotate the knob clockwise to 
pan the signal right, and counter-clockwise to pan left.

[BAL] control
This control determines the volume balance between 
the left and right stereo channels. Odd channel 
signals are fed to the L bus, and even channel 
signals are fed to the R bus. For example, rotate the 
[BAL] control all the way to right to output only the 
even (right) channel signals.

Caution
• Be sure to leave this switch off ( ) if you do not need 

phantom power.
• When turning the switch on ( ), make sure that only 

condenser microphones are connected to the INPUT A jacks. 
Devices other than condenser microphones may be 
damaged if they are connected to the phantom power supply. 
Note, however, that the switch may be left on when you 
connect balanced dynamic microphones.

• To avoid damage to your hearing or speakers, be sure to roll 
off the volume level of the amplifier (or powered speakers) 
before turning this switch on or off. Yamaha also 
recommends that you turn all output controls, such as the 
STEREO fader and [C-R PHONES LEVEL] control to 
minimum settings before operating the switch.

Use an unbalanced cable when you connect an electric 
guitar or bass and turn the [Hi-Z] switch on. If you use a 
balanced cable, the mixer will not work correctly.

For more information on how to use the compressor, 
please refer to page 28.

NOTE

NOTE

Band Type Center Frequency Maximum 
Cut/Boost

HIGH shelving 10 kHz ±18 dB

MID peaking 100 Hz – 10 kHz ±18 dB

LOW shelving 90 Hz ±18 dB

When the Channel Control [WET] switch is on, 
signals via a DAW will be directly routed to the AUX 
bus (Monitor Remote function). Therefore, the [AUX] 
control will be temporarily disabled while the [WET] 
switch is turned on.

NOTE
Owner’s Manual
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# [SOLO] switch
This switch turns the Solo function on and off. Turn 
this switch on (the switch LED lights up), if you want 
to listen to certain channels without changing the 
mix contents or signal path.

$ Channel [ON] switch
Switches each channel on and off. If you turn the 
switch on, the channel signal will be sent to each 
bus. When the switch is turned off (the switch 
indicator turns off), the channel signal will be sent 
only to the AUX bus.

% Channel fader
The channel fader adjusts the input channel signal 
level. The fader at the “0” position corresponds to 
the nominal output level. This means that the pre-
fader level and post-fader level are identical.

^ Input meter
The four LEDs indicate the input channel signal 
level. When the input signal is clipping, the OVER 
LED will light up.

 You can check the level of the post-fader 
signal via the input meter by setting the [INPUT 
METER] switch (page 17) in the Meter section to 
“POST.”

& [WET] switch
This switch determines whether or not the input 
channel monitor signal will be processed via the 
Monitor Remote function. If you turn this switch on 
(the LED lights up) while Cubase and the mixer are 
linked and operating together, you can monitor a wet 
signal (an input signal that has been processed via 
the VST or other effects).

* [REC] switch and [ST] switch
These switches route the signal to the specified 
buses. Turn the [ST] switch on (the LED lights up) to 
route the channel signal to the stereo L/R buses. 
Turn the [REC] switch on to route the channel signal 
to the REC (L/R) buses.

If you switch the monitor source by using the [C-R 
SOURCE SELECT] switch (page 18), all channel 
[SOLO] switches will be reset to off.

Direct output to a connected computer is always 
available regardless of the channel [ON] switch 
status.

• While this switch is turned on, the [AUX] control 
for the corresponding input channel will be 
disabled.

• To use the Monitor Remote function, you must 
turn on the MONITOR REMOTE [ON] switch 
(page 19) (the switch LED will light up).

NOTE

NOTE

Only

NOTE

Tip for compensating for the phase offset
When you are recording a single instrument using 
multiple microphones, the position and the distance 
between the instrument and microphones may cause 
the phase of each recorded signal to be offset 
against each other (out of phase). If you try to mix 
such signals, the signals will interfere with each 
other, resulting in a thin sound.
For example if you record the sound of a guitar 
amplifier by placing microphones in front of and 
behind it in order to capture the resonance of the 
cabinet, the microphone placed behind the amplifier 
will pick up a signal with an offset phase. In this 
case, turn the [PHASE] switch (5) on to avoid the 
phase offset and interference.

phase 
offsetphase of mic 

signal from 
behind

phase of mic 
signal from in 

front
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Master Control section

1 Reverb section
This section enables you to set the type, output level, 
and other settings for the internal digital reverb.

REVERB [TYPE] switch
This switch determines the type of internal digital reverb.
Each press of the switch cycles through different 
effect types in this order: HALL → ROOM → PLATE.

[REVERB TIME] control
This control adjusts the reverb time (duration of 
reverberation) of the internal digital reverb. Rotating 
the knob counter-clockwise will shorten the duration, 

and rotating it clockwise will extend the duration.

REVERB [LEVEL] control
This control adjusts the output level of the internal 
digital reverb. The “▼” position corresponds to the 
nominal level (0 dB).

[TO AUX]/[TO REC]/[TO ST] switches
These switches route the output signal from the internal 
digital reverb to the AUX, REC, or STEREO buses. Turn 
the desired switch on ( ) to route the output from the 
internal digital reverb to the desired buses.

2 2TR TO ST section
This section enables you to adjust the level of and 
route the signal input from the 2TR IN jacks (page 20).

[LEVEL] control
Adjusts the level of the signal input from the 2TR IN jacks. 
The “▼” position corresponds to the nominal level (0 dB).

[ON] switch
This switch determines whether the 2TR IN signal will be 
sent to the STEREO buses. When the switch is turned on 
( ), the 2TR IN signal is sent to the stereo buses.

3 DAW TO ST section
This section enables you to adjust the level of and 
route the stereo signal transmitted from the DAW 
(DAW IN 1/2).

[LEVEL] control
This control adjusts the level of the stereo DAW 
signal to the STEREO buses. The knob set to the “▼” 
position corresponds to the nominal level (0 dB).

[ON] switch
This switch determines whether the stereo output signal 
from the DAW will be routed to the STEREO buses. 
When the switch is turned on ( ), the stereo output 
from the DAW will be sent to the mixer’s STEREO buses.

4 STEREO [BAL] control
This control adjusts the left and right volume balance 
of the stereo channels (STEREO L/R).

5 [PFL] (Pre-Fader Listen) switch
If you want to monitor pre-fader input channel 
signals when you are using the Solo function, turn 
this switch on ( ).

6 STEREO [ON] switch
This switch turns on and off the signal output from 
the ST OUT jacks. When the switch is on ( ), the 
signal is output from the ST OUT jacks.

7 STEREO fader
This fader adjusts the level of the signal output from 
the ST OUT jacks. The “0” position corresponds to 
the nominal output level (0 dB).

HALL Simulates reverberation in a concert hall.

ROOM Simulates reverberation in a room.

PLATE Simulates reverberation of a plate echo.

1

2

3

4

5

6

7

 If you turn on the C-R SOURCE SELECT 
[5.1] switch, the DAW TO ST [ON] switch will be 
disabled.

 While this switch is turned on, if you also 
turn the [SOLO] switch on, the monitor signal 
volume may become very loud. In this case, use the 
[SOLO LEVEL] control (page 17) to adjust the 
monitoring volume level. The monitoring volume 
level of the n8 is always attenuated by 12 dB.

NOTE Only

NOTE Only
Owner’s Manual
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Meter section

1 Microphone 
This is a built-in talkback microphone.

2 [SOLO LEVEL] control 
This control adjusts the SOLO L/R bus output level. The 
adjustable range is from –∞ to +6 dB. The “▼” position 
corresponds to the nominal output level (0 dB).

3 [DAW TO AUX] control
This control adjusts the level of the signal routed 
from the DAW AUX output (n12= DAW IN 15/16, n8= 
DAW IN 11/12) to the AUX buses. The “▼” position 
corresponds to the nominal output level (0 dB).

4 [AUX LEVEL] control 
Adjusts the AUX OUT signal level (page 21). The “▼” 
position corresponds to the nominal output level (0 dB).

5 AUX PHONES jack
This headphone connector outputs the AUX bus 
signal. Use this connector to send a monitor signal 
to the musicians. The output level at this jack can be 
adjusted independently of the AUX OUT jacks.

6 [AUX PHONES] control
This control adjusts the output level at the AUX 
PHONES jack. The “▼” position corresponds to the 
nominal output level (0 dB).

7 C-R PHONES jack
This headphone jack outputs the control room 
signal. The output level at this jack can be adjusted 
independently from that of the C-R OUT jacks.

8 [C-R PHONES] control
This control adjusts the output level at the C-R 
PHONES jack. The “▼” position corresponds to the 
nominal output level (0 dB).

9 CUBASE READY indicator
This indicator lights up when the mixer is ready to be 
operated with Cubase 4/Cubase Studio 4/Cubase 
AI4; that is, when the computer is connected to the 
n8/n12 and Cubase is linked to the mixer correctly.

) MASTER LEVEL METER

■ n12
This meter indicates the level of the STEREO/REC/AUX 
bus signals, or the output level at the C-R OUT jack. To 
switch the meter view, use the [METER SELECT] switch 
(!). Depending on the setting of the [METER SELECT] 
switch, the meter indication will change as follows:

* Surround channels are indicated in parentheses.

■ n8
This meter indicates the output level at the C-R OUT 
jacks.

! [METER SELECT] switch 
This switch determines which signal will be indicated 
via the MASTER LEVEL METER. Pressing the switch 
will toggle between C-R (C-R OUT jacks) and BUS 
(STEREO/REC/AUX bus).

@ [INPUT METER] switch 
This switch selects the signal whose level is 
indicated on the input meter (page 15) in the 
Channel Control section. Pressing the switch 
repeatedly toggles between PRE (pre-fader) and 
POST (post-fader).

n12 n8

2

@

1

43 65

8

!

7

) 9

3 8

56 7

9

)

While you are using the Monitor Remote function 
(page 33), signals that pass through the DAW will be 
directly routed to the AUX bus.

Only

Only

Only

NOTE

[METER 
SELECT] 
switch

Meter A Meter B Meter C

C-R*
C-R OUT 
jacks A 

(L/R)

C-R OUT 
jacks B 
(C/SW)

C-R OUT 
jacks C 
(LS/RS)

BUS STEREO 
bus REC bus AUX bus

Only

Only
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Control Room section

1 C-R SPEAKER SELECT switches 
These switches select the jacks that will output the 
control room monitor signal. When you turn on one of 
the switches, the LED lights up, and the 
corresponding jacks output the monitoring signal.

2 [DOWN MIX] switch 
This switch converts 5.1-ch surround signals (input 
from the DAW) into 2-ch L/R signals. While the 
switch is on, converted 2-ch signals are output from 
the C-R OUT jacks A.

3 C-R SOURCE SELECT switches
These switches enable you to select a monitoring source 
(the signal output from the C-R OUT jacks). The 
following switches and monitoring sources are available:

4 [DIMMER] switch
This switch turns on and off the Dimmer function that 
temporarily lowers the monitoring volume. For 
example, this can be convenient when you want to 
have a conversation in the control room.

5 [MUTE] switch
This switch turns on and off the Mute function that 
mutes the monitoring signal. Repeatedly pressing 
the switch toggles between on (the switch will light 
up) and off (the switch will turn off).

6 [CONTROL ROOM LEVEL] control
This control adjusts the monitoring volume in the 
control room. Turning the knob clockwise will 
increase the volume level.

7 TALKBACK [LEVEL] control 
This control adjusts the input level of the built-in 
microphone. The “▼” position corresponds to the 
nominal level (0 dB).

8 [TALKBACK] switch 
While this switch is being pressed, you can 
communicate with the musicians (Talkback function).
When the Talkback function is turned on, the switch LED 
will flash and the Dimmer function (4) will be enabled.

6

4

3

5

1

4

6

7

2

85

3

n12 n8

Switch Output jacks

C-R SPEAKER SELECT [A] 
switch C-R OUT jacks A (L/R)

C-R SPEAKER SELECT [B] 
switch C-R OUT jacks B (L/R)

C-R SPEAKER SELECT [C] 
switch C-R OUT jacks C (L/R)

While the C-R SOURCE SELECT (3) [5.1] switch is 
turned on, you can use these switches to individually 
turn the surround channels on and off. For more 
information, please refer to page 47.

• In order to monitor in a surround environment, you will 
need a surround-capable application such as Cubase 4. 
The included Cubase AI4 does not support surround.

• This switch is effective only while the C-R 
SOURCE SELECT [5.1] switch is turned on.

[5.1] switch Enables you to monitor the 5.1-ch surround 
signal input from the DAW. (page 46)

[DAW] 
switch

Enables you to monitor the DAW stereo 
signal (DAW IN 1/2).

[ST] switch Enables you to monitor the STEREO 
bus signal.

[AUX] 
switch

Enables you to monitor the AUX bus 
signal.

[2TR] 
switch

Enables you to monitor only the input 
signal at the 2TR IN jacks.

Only

NOTE

Only

NOTE

Only

•  In order to monitor in a surround 
environment, you will need Cubase 4. The 
included Cubase AI4 does not support surround.

• You can turn on the [5.1] switch and [ST] switch 
simultaneously. In this case, the 5.1-ch L/R signal 
and STEREO bus L/R channel signals will be 
mixed and output.

The talkback signal will be sent to the AUX outputs 
(AUX PHONES jack and AUX OUT jacks).

NOTE Only

Only

Only

NOTE
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DAW Remote Control section

1 WORK MODE switches
These switches enable you to change the connection 
status between the n8/n12 and Cubase all at once. The 
following connection settings (Work modes) can be 
selected depending on your needs. Pressing each 
switch changes I/O settings and bus assignments.

2 MONITOR REMOTE [ON] switch
This switch turns on and off the Monitor Remote 
function that enables you to process the input 
channel and REC bus signals via the VST effects and 
monitor them. When the switch is turned on (the 
switch will light up), the input channel [WET] switches 
(page 15), the MONITOR REMOTE [REC BUS WET] 
switch (3), and other switches become available.

3 MONITOR REMOTE [REC BUS WET] switch
This button determines how to monitor the signals 
that is being recorded via the REC bus with the 
Monitor Remote function (page 33). When this switch 
is on, you can monitor the REC bus signals that have 
been processed within Cubase by VST effects, etc.

4 CLICK REMOTE [ON] switch
This switch remotely turns on and off the metronome 
(click sound) in Cubase. If you turn the metronome 
ON in Cubase, this switch will reflect the setting.

5 [CLICK LEVEL] control
This control adjusts the volume level of the Cubase 
metronome (click sound). Turning the knob 
clockwise will raise the volume, and turning the knob 
counter-clockwise will lower the volume.

6 TRACK CONTROL switches
These switches remotely control Cubase tracks. 
Each switch features the following function:

7 TRANSPORT switches
These switches remotely control the transport section 
in Cubase. Each switch has the following function:

4
52

1

3

6

7

4
2

1

3

6

7

5

n12 n8

All switches in this section are enabled only when 
the n8/n12 is connected to the computer via an 
IEEE1394 cable and the mixer’s operation is linked 
to Cubase 4/Cubase Studio 4/Cubase AI4. For more 
information on the Cubase Link function, please 
refer to page 33.

ST MIX
Enables you to monitor on the n8/n12 the 
stereo signal mixed in the Cubase mixer 
and output from the DAW.

HARDWARE 
MIX

Enables you to output Cubase audio 
tracks individually to the n8/n12, then mix 
them on the n8/n12.

5.1 MIX Enables you to create a 5.1-ch 
surround mix in Cubase 4.

For information on operations in each Work mode, 
please refer to page 37.

• To use the Monitor Remote function, turn on the 
MONITOR REMOTE [ON] switch (2) (the switch 
LED will light up).

• To monitor an effect signal that has been 
processed by the VST effects, you must turn on 
the Record Enable button for the destination audio 
track in Cubase.

NOTE

Only

NOTE

NOTE

[PREV ▲] 
switch

Selects the previous track (the track 
one above in the track list) in Cubase.

[NEXT ▼] 
switch

Selects the next track (the track one 
below in the track list) in Cubase.

[REC READY] 
switch

Turns on and off the Record Enable 
button for the track selected in Cubase.

[CYCLE] switch Turns Cycle mode on and off.

[ ] switch

Moves the current position to the 
previous marker (or the beginning of 
the project if there is no marker in the 
backward direction).

[ADD] switch Adds a marker at the current 
position.

[ ] switch Moves the current position to the 
next marker.

[ ] switch Rewind

[ ] switch Fast forward

[■] switch Stops the project playback.

[ ] switch Plays the project.

[REC] switch Records the track(s) whose 
Record Enable button is on
Owner’s Manual 19



Front and Rear Panels

20

En
gl

is
h

Rear I/O section

1 ANALOG INPUT jacks (monaural)
These monaural channel input jacks are used to connect 
microphones or musical instruments. Each input channel 
features two types of jacks (INPUT A and INPUT B).

INPUT A jacks
These are balanced XLR-type input jacks.

INPUT B jacks
These are balanced TRS phone-type input jacks that 
also support unbalanced connections.

2 INSERT I/O jacks
These phone-type unbalanced I/O jacks are 
positioned immediately before the A/D converter. 
You can connect your effects processor or other 
devices directly to these input channels.

3 ANALOG INPUT jacks (stereo)
These are stereo input jacks that connect line-level 
instruments, such as a synthesizer. Two jack types 
are provided: phone type and RCA pin type.

Phone type
These are unbalanced stereo input jacks.

RCA pin type
These are unbalanced stereo input jacks.
Connect odd channels to the L jacks, and even 
channels to the R jacks. If you connect only odd 
channels to the phone-type jacks, the same signals 
will be fed to the even channels, resulting in 
monaural inputs.

4 2TR IN jacks
Use these unbalanced RCA pin jacks to input a 
stereo sound source.
Use these jacks when you want to connect a CD or 
other music source to the n8/n12 for monitoring.
You can adjust the level of signals input via these 
jacks using the [2TR TO ST] control (page 16) in the 
Master Control section.

9

!@ 7 6 5 2

8 ) 4 3 1

256@

9 8 ) 4 3 1

!

n12

n8

You may use either of these jacks, but you may not 
use both at the same time. If you connect cables to 
both jacks, INPUT B jack will take priority.

These are TRS phone jacks that support bidirectional 
operation. Connection to an INSERT I/O jack 
requires a special insertion cable as illustrated below. 
Use a separately-sold Yamaha insertion cable 
(YIC025/050/070).

NOTE

NOTE

To the INSERT I/O jack

sleeve
ring

tip

sleeve tip

To the output jack of 
the external processor

To the input jack of the 
external processor

If you connect cables to both phone type and RCA 
pin type jacks, signals are mixed before the [GAIN] 
control, then input to the corresponding channel.

NOTE
Owner’s Manual
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5 ST OUT jacks
These stereo jacks output the mixed signal, and are 
suitable for use as the main output for a small 
concert or other event. The signal level is adjusted 
via the STEREO fader, then the signal is output from 
these jacks. You can use these jacks, for example, 
to send the stereo mix to the master recorder, or to 
connect to the power amplifier driving your main 
speakers.
These jacks feature two types: phone type and RCA 
pin type, and the same signal will be output from 
either type of jack.

Phone type
These are stereo output jacks that support both 
balanced and unbalanced signals.

RCA pin type
These are unbalanced stereo output jacks.

6 C-R OUT jacks
These are stereo output jacks that support both 
balanced and unbalanced phone-type connections 
for the Control Room monitor.
The signal level is adjusted in the Control Room 
section (page 18) before it is output.

 The signal monitored by these jacks is 
selected via the C-R SPEAKER SELECT switches 
(page 18).

7 AUX OUT jacks 
These stereo jacks output AUX bus signals. They 
support both balanced and unbalanced phone-type 
connections. You can use these jacks, for example, 
to connect musicians’ monitor speakers, or to send 
the input channel signal to a connected external 
device, such as an effects processor.
The output level at these jacks can be adjusted via the 
[AUX LEVEL] control (page 17) in the Meter section.

8 MIDI IN/OUT jacks
These jacks are used to connect external MIDI devices, 
such as a synthesizer, via MIDI cables. If you are 
connecting the n8/n12 to a computer via an IEEE 1394 
cable, these jacks serve as a MIDI interface that 
connects the computer to external MIDI devices.

9 DAW I/O jacks
These 6-pin IEEE 1394 (S400) jacks are used to 
connect a computer to the mixer via a IEEE 1394 cable.
Both jacks feature the same functionality. You can 
use one of them to connect a computer, and the 
other connector to connect daisy-chained devices.
If your computer has a 4-pin IEEE 1394 jack, use a 
4-pin to 6-pin type IEEE 1394 cable that meets the 
S400 specifications.

) FOOT SW jack
Connect an optional foot switch (such as Yamaha 
FC4 or FC5) to this jack. In this way, you can control 
the transport functions of Cubase 4/Cubase Studio 
4/Cubase AI4 using your foot. By default, the foot 
switch will operate as the Mackie Control “USER 
SWITCH (A).” If necessary, you can make settings 
within your DAW to change the assignment.
With the default settings in Cubase, this will perform 
the same operation as the [REC] button.

! POWER switch
This switch sets mixer power to ON or STANDBY.

@ AC INPUT jack
Connect a power adaptor here (refer to page 8).

Only

Only

Caution
Be sure to connect the IEEE1394 cable plug to the DAW I/O 
jack in the correct orientation.

• Use an IEEE 1394 cable that meets the S400 
standard. Yamaha recommends that you use an 
IEEE 1394 cable with a length of 4.5 meters or 
less.

• Connect your IEEE 1394 cables so that they do 
not create a loop. For more about loop 
connections, refer to page 53.

Caution
Note that a small amount of current continues to flow while the 
switch is in the STANDBY position. If you do not plan to use the 
mixer for a long period of time, please be sure to unplug the 
adaptor from the wall outlet.

Plug in the jack in the correct orientation.

NOTE
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Setup Procedure

1. Before connecting microphones and other 
instruments to the mixer, make sure that the 
power to all devices is turned off. Also, make 
sure that all of the mixer’s channel faders and 
master control faders are set all the way down.

2. For each channel connection, connect one end of 
the cable to the relevant microphone or instrument 
and securely connect the other end to the 
appropriate input jack on the mixer.

3. To avoid loud pop noises and possible damage 
to your speakers, turn on the power to the 
devices in the following order: peripheral devices 
→ n8/n12 → power amps (or powered speakers).
Turn off the power to the devices in the reverse 
order: power amps (powered speakers) → n8/n12 
→ peripheral devices).

n12 Setup Example (Home recording)

Setting Up the Mixer

You cannot use both INPUT A and INPUT B jacks for each 
input channel. If you connect cables to both jacks, INPUT B 
will be used and INPUT A will be disabled.

NOTE
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n8 Setup Example (Home recording)

Installing Monitor Speakers

The position of the monitor speakers is very important for accurate sound monitoring. Refer to the following tips before 
you decide on a location and position for the monitor speakers.

■ Distance from the walls and 
corners

To monitor the sound accurately, locate the speakers far 
from the walls and corners. As the speakers move 
closer to the walls or corners, sound reflection from the 
walls will emphasize the low range, reducing the quality 
of the speaker response. (Ideally, keep a distance of 
minimum 1.5 meters from the walls.) If you have no 
other choice, adjust the frequency response for the 
monitoring environment (such as equalizing the speaker 
frequencies) or slightly cut the low range during the mix.

■ Distance and angle from the 
listening point

Place L and R channel speakers so that they and the 
listening point will form an equilateral triangle. Position the 
speakers so that the face of the speakers are pointing 
toward the listening point. Keep an equal distance between 
the speaker and the listening point for each speaker so that 
the left and right monitor signals will be well-balanced. 
Adjust the speaker height so that the tweeter will be at the 
same height as your ears. In this way, you will be able to 
hear higher ranges, which project at a narrow angle.
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Here are the basics for using your n8/n12 as a stand-alone mixer.

Let’s Hear It!

Connecting sound sources and 
monitor devices
Nothing happens until you connect musical instruments, 
microphones, other sound sources, and monitoring speakers 
to the mixer and turn on the power to the mixer. So...

1. Make sure that the power to all devices is turned off, 
then connect musical instruments, microphones, 
and other sound sources to the mixer.
Refer to “Setup Procedure” on page 22 for more 
information on connections.

2. Set all faders on the mixer to minimum.

3. Turn on the power to all the devices in the 
following order: connected instruments and 
microphones → n12/n8 → monitor speakers.
Make sure that you turn on the power to the devices 
starting with the input sources in the order of connection. 
Otherwise, a rather loud noise may blow you away!

Adjusting the gain
A gain control is used to mach the input’s sensitivity to the 
signal from, for example, connected instruments or 
microphones. The n12/n8 enables you to input two signal 
types: analog signals from instruments or microphones 
connected to the rear panel, and digital signals transferred 
from Cubase or other DAWs. Here is how you select analog 
signals as input sources and adjust the input sensitivity.

1. Set the [INPUT SELECT] switch of the input 
channel that is connected to your musical 
instrument to “A.IN.”
When the switch is set to “A.IN,” analog signals will 
be input to the corresponding input channel.

A Hands-On Guide to the n8/n12

Caution
• Make sure that the PHANTOM [48V] switch is turned off 

( ) when phantom power is not required.
• Make sure that NO equipment other than phantom-powered 

microphones is connected to the channel inputs when the 
corresponding channels’ phantom power is on. Applying 
phantom power to equipment other than phantom-powered 
microphones can damage the equipment. The exception to this 
rule is balanced dynamic microphones, which can safely be left 
connected while phantom power is applied to the XLR inputs.

• When you switch phantom power on or off, a loud noise may be 
output, which could result in speaker or hearing damage. To 
avoid this, lower the level of your power amplifier (or powered 
speakers) to minimum before switching phantom power on or 
off. Also, set the STEREO faders, [PHONES LEVEL] control, 
and other output level controls to the minimum levels.

DI

If you are connecting an 
electric guitar or electric 
bass that has passive-type 
pickups and does not have 
a built-in preamp, connect 
it to input channel 8 (on the 
n12) or input channel 4 (on 
the n8), and press the [Hi-
Z] switch of that channel to 
the on ( ) position. If 
you connect a guitar or 
bass to other channels, 
use a DI box (direct box) or 
amp simulator between the 
instrument and the mixer.

To send a 
monitoring signal 
exclusively to 
the player, 
connect a set of 
headphones to 
the AUX 
PHONES jack.

When you use 
condenser microphones, 
turn the corresponding 
channel PHANTOM [48V] 
switches on.

A good rule of thumb for recording via microphones is 
to turn the high-pass filter on for microphone channels, 
except in very special cases. As the name implies, a 
“high-pass filter” cuts only those signals that fall below 
a certain frequency. When an n12/n8 high-pass filter is 
turned on, signals below 80 Hz (which are very low 
frequency components) are cut. This can be useful for 
minimizing low-frequency breath noise from a vocalist, 
as well as noise caused by handling the microphone, 
or rumble transmitted via the microphone stand.

When the [INPUT SELECT] switch is set to “DAW,” 
you can input signals from Cubase or another DAW 
to the input channels. For more information, please 
refer to page 43
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2. If you are using the n12, set the [INPUT METER] 
switch in the Meter section to “PRE.”
You can select pre-fader signal level or post-fader 
signal level for the input meters. (A “pre-fader” 
signal is taken from a point before the channel fader. 
A “post-fader” signal is taken from a point after the 
channel fader.) As you might guess, the meters will 
display pre-fader signal levels if you select “PRE,” 
and post-fader signal levels if you select “POST.”
When you are adjusting the input sensitivity (gain), 
keep your eyes on the pre-fader signal meters.

3. Turn the [PAD] switch on or off for each 
monaural input channel, depending on the 
connected instrument or microphone.

4. While playing the instrument or singing into the 
microphone at the loudest expected level, 
gradually rotate the corresponding [GAIN] 
control clockwise without the input meter’s 
OVER LED lighting up.
In order to record the sound with a wide dynamic 
range and minimum noise, raise the input sensitivity 
as high as possible without the input signal clipping.

Setting up the monitoring 
environment
Of course you need to hear what is going on, right? That 
is called “monitoring.” You can monitor the input 
channel signals through connected monitor speakers or 
headphones.
The n12 also provides C-R SPEAKER SELECT switches 
that let you select one output destination from multiple 
monitor speakers.

1. Turn on the appropriate Control Room [C-R 
SOURCE SELECT] switch corresponding to the 
signals that you want to monitor.
The following signals are available as monitoring 
sources in the control room:

The C-R SOURCE SELECT switch indicators will tell 
you which monitor source is currently selected. In 
this example, press the [ST] switch to select the 
stereo bus signal as a monitor source.

2. Turn the [CONTROL ROOM LEVEL] control or [C-
R PHONES] control to adjust the monitoring level.
You can adjust the level of each monitor individually. To 
adjust the monitor speaker level, use the [CONTROL 
ROOM LEVEL] control. To adjust the Control Room 
headphone level, use the [C-R PHONES] control.
To avoid damages to your hearing ability and/or 
speakers during monitoring, set the monitoring level 
rather low, then re-adjust the level later to suit your 
taste during mixing.

If you are using the n8, the meters always display 
pre fader signal levels.

To achieve a clear sound with the least noise, 
amplify the input to the desired average level as 
early as possible in the signal path. That means that 
you should amplify the input using the [GAIN] control 
in the head amplifier as much as possible. But, 
remember: too much initial gain is bad, because it 
will cause clipping, and will distort the sound. 
Amplify the signal to a level “just below clipping.”

PRE

NOTE

NOTE

[5.1] switch Enables you to monitor a 5.1 channel 
surround signal input from the DAW.

[DAW] switch Enables you to monitor the DAW 
stereo output (DAW IN 1 & 2).

[ST] switch Enables you to monitor the stereo 
bus signal.

[AUX] switch Enables you to monitor the AUX bus 
signal.

[2TR] switch Enables you to monitor the input 
signal from the 2TR IN jacks.
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3. Players want to hear what is going on. Use the 
[AUX] control of the input channel that connects 
the instrument or microphone to adjust the 
output level to the AUX bus so that the 
corresponding player or singer can hear their 
part.
The AUX bus can be used in various ways. Two 
common applications are 1) to create a monitor mix 
that is separate from the main mix and that can be 
used by players in a recording booth or on the 
stage, and 2) to process the signal via an external 
effect unit, such as reverb and delay.
On the n8/n12, a pre-fader signal is routed from 
each input channel to the AUX bus. You can create 
an independent monitor mix by setting each input 
channel [AUX] control to a mix balance that is 
different from the fader setting.
The AUX bus signal is output from the AUX PHONES 
jacks (or the AUX PHONES jacks and AUX OUT 
jacks on the n12). Rotate the level control of the 
corresponding jacks to adjust the monitoring level.
To avoid damage to your hearing or speakers, set 
the monitoring level rather low, then re-adjust the 
level later to suit your taste during mixing.

Adjusting the volume level
Adjust the volume level while monitoring the input 
channel signals.

1. Press the STEREO [ON] switch in the Master 
Control section to turn it on, then raise the 
STEREO fader to the “0 (0 dB)” marking on the 
fader scale.
When the STEREO fader is set to the 0 (0 dB) 
position, the stereo bus output signal is at its 
nominal level (that is, the pre-fader and post-fader 
signal are at the same level).

2. Press the input channel [ON] switch and [ST] 
switch to turn them on.
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3. Adjust the volume level of the input channels to 
which your instruments or microphones are 
connected by moving the corresponding faders.
On the n12 if you set the Meter section’s [INPUT 
METER] switch to POST, you will be able to use the 
input meter of each channel to check the post-fader 
signal level. If the C-R SOURCE SELECT [ST] switch 
in the Control Room section is turned on, you can 
monitor the STEREO bus signal in the Control Room.
If necessary, re-adjust the monitoring level by 
rotating the [CONTROL ROOM LEVEL] control or the 
[C-R PHONES] control.
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Making Great Mixes

Manipulating compression
The n8/n12 features a high-quality compressor inherited 
from Yamaha’s cutting-edge digital mixers, acclaimed 
by engineers all over the world.
A compressor is an effect that restrains the peak levels of 
an input signal while enhancing the overall loudness of the 
signal. Today, compressors are used in virtually every 
recording environment as an important effect that 
significantly influences the character of the sound. 
However, most compressors require specialized knowledge 
and experience in order to obtain the optimal results.
The n8/n12 use newly-developed Sweet Spot Morphing 
Technology to deliver professional-quality results with 
easy operation. The compressors of the n8/n12 contain 
preset settings (Sweet Spot data) that were created by 
top-class engineers and can be used simply by adjusting 
(morphing) the Sweet Spot Data according to your taste.
By accessing the Yamaha website, you can download 
to your computer various types of Sweet Spot data 
created by famous engineers. The downloaded Sweet 
Spot data can then be replaced to the n8/n12 if it is 
connected to the computer.

■ Which compressor setting 
suits you?

Rotate the compressor’s [MORPH] control to select one 
of the Sweet Spot settings. These Sweet Spot settings 
(A-E) contain different compressor presets (Sweet Spot 
data) created by famous sound engineers. Select one 
and the corresponding preset data will be recalled.

If you set the [MORPH] control to a position between two 
Sweet Spot settings, the compressor will use data from 
between those settings. For example, if you set the control 
to halfway between Sweet Spots A and B, the compressor 
will apply the values that correspond to exactly halfway 
between the values for Sweet Spots A and B. As you 
rotate the control toward the Sweet Spot B position, the 
values will become closer to those of Sweet Spot B.
In this way, you can set the compressor on the n8/n12 
more intuitively using Sweet Spot data.

When shipped from the factory, Sweet Spots A-E use 
the following settings:

■ Want to tweak the compression?
Use the [DRIVE] control to adjust the degree of compression.
As you rotate the control clockwise, additional compression 
is applied, and the output level is automatically adjusted 
according to the degree of compression. You do not need 
to be a high-tech wizard to control this compressor!
At a setting of “0,” no compression is applied.
When an input signal level exceeds a specified level 
and the compressor is triggered, the corresponding 
input channel [COMP] LED lights up. While listening 
carefully, adjust the sound to your taste.

For more information on updating Sweet Spot data, 
please refer to page 48.

NOTE

Sweet Spot A

Sweet Spot B

Sweet Spot C

Sweet Spot D

Sweet Spot E
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E A
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E A

B

C

D

E A

B

C
D

E

A B C D

A/B=50%

A=100% B=100% C=100% D=100% E=100%

B/C=50% C/D=50% D/E=50%

E

A
Natural-sounding compression that makes the 
sound smoother. We recommend that you use 
a fairly low depth setting for the compressor.

B Enriches the decay of the sound.

C Emphasizes the attack of the sound. A good 
choice for drums or guitar.

D Slightly squashes the attack, making the attack 
more consistent.

E

Squashes the sound to make the volume constant. 
Depending on the input signal, the sound may 
distort. When applied to drums, this can produce a 
sound that is typical of British rock of the 60’s.

How a compressor works
A compressor suppresses the input signal peaks and 
raises the overall sound pressure level to increase the 
body of the sound. When an input signal level exceeds 
a specified threshold, the compressor is triggered and 
compresses the signal.
When the signal level falls below the threshold, 
compression is removed.
How quickly the signal level changes after the 
compressor is triggered or removed depends on the 
compressor’s setting. For example, if you select a 
setting with a slow response, the level will change 
gradually and more naturally. If you select a setting 
with a quick response, the level will change quickly.
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input signal

compressed level

compressor triggered compressor removed
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Mastery of EQ
Each input channel features a three-band (high/mid/low) 
equalizer.
An equalizer boosts (amplifies) or cuts (attenuates) 
certain frequency ranges to shape the tone. It can be 
used to modify the tone to suit the acoustic 
characteristics of a room, to make creative sounds, or 
for many other purposes.
One particularly important application of EQ is to give 
the overall sound better definition by eliminating 
interference between instruments’ frequency ranges in a 
mix. Remember: less is more. Modest use of 
equalization will lead to a great, natural sounding mix.

■ Boosting or cutting certain 
frequency ranges

To boost or cut certain frequency ranges of the input 
signal, use the gain controls for equalizer. As you rotate 
a control clockwise, the corresponding range will be 
boosted, and as you rotate the control counter-
clockwise, the range will be cut. When the control is set 
to the “▼” position, that frequency range will not be 
boosted or cut (i.e., its response will be “flat”).

Boosting the signal too much using the equalizer will 
add gain to the signal, increasing noise and potentially 
overloading the circuitry and distorting the sound. In this 
case, step back and make sure that you have not 
boosted too much with EQ (remember, less is more!), 
and lower the gain if necessary.

■ Adjusting the mid-band 
center frequency

The mid-band equalizer enables you to adjust the 
center frequency at which the sound will be boosted or 
cut. This is useful when you want to adjust the boost/cut 
frequency ranges to accommodate a snare drum pitch 
or vocal tone.
To adjust this center frequency, use the [MID] 
frequency control. As you rotate the control clockwise, 
the center frequency is raised, and as you rotate the 
control counter-clockwise, the center frequency is 
lowered. When the control is set to the “▼” position, the 
center frequency will be 1.0 kHz.

Before you adjust the center frequency, it is a good idea 
to boost the mid-band signal with the [MID] gain control. 
In this way, you can easily hear and verify the frequency 
that you are selecting. When you finish adjusting the 
frequency, re-adjust the [MID] gain control to your taste.

S
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N
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V
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B
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FREQUENCY RANGE (Hz)

MID flat

HIGH boost 
(amplify)

HIGH flat

HIGH cut 
(attenuate)

LOW boost 
(amplify)

LOW flat

LOW cut 
(attenuate)

MID cut 
(attenuate)

MID boost
(amplify)

100Hz 1.0kHz 10.0kHz

[MID] frequency control

CENTER FREQUENCY (Hz)

boosted signal
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Panning and balancing
“Pan” is derived from “panorama” and is related to the 
concept of a “stereo image.”
Panning creates the illusion of stereo space by changing 
the relative levels of each track’s signal sent to the left and 
right speakers. If a signal is sent to only the left speaker, 
the sound will seem to come from the far left side of the 
stereo sound field. Thus we feel as though the instrument is 
being played on the left side. If a signal is sent at equal 
levels to both left and right speakers, our ears will tell us 
that the sound is located in the center of the stage. Not only 
does the way you pan your individual channels determine 
where the instruments seem to appear in the stereo sound 
field, but it is also vital to give each instrument its own 
“space” so that it does not conflict with other instruments.

■ Panning a monaural track
Pan a monaural input channel signal by turning the [PAN] 
control. Rotating the control clockwise raises the ratio of 
signal sent to the R bus. Rotating the control counter-
clockwise raises the ratio of signal sent to the L bus.

■ Adjusting the stereo track 
balance

Adjust the left and right volume balance of stereo 
channels. The odd channel signal will be sent to the L 
bus, and the even channel signal to the R bus.

Mixing into stereo
Now it is time to “mix.” Adjust the volume balance 
between the input channels and mix all channels into 
the stereo bus. 
The mixed signals will be output from the ST OUT jacks 
and monitored through the Control Room section.

1. Lower all channel faders all the way down.
It is usually a good idea to start with all channel 
faders off. It is also possible to start with all faders at 
their nominal settings, but it is too easy to lose 
perspective (balance) with this approach.
Start with all faders down, then bring them up one by 
one to fill out the mix with each instrument. In this 
way, you can easily create a well-balanced mix.

2. Make sure that the [ST] switch for the input 
channels you plan to mix is turned on.

3. Set the STEREO fader to the 0 position, and make 
sure that the STEREO [ON] switch is on.

4. Raise the input channel faders one by one.
Bring the fader of the most important channel up to 
“0” (0 dB), then add the other instruments so that 
you can build the mix around that part. This is a key 
to a well-balanced mix.

5. Adjust the STEREO fader while keeping your 
eyes on the MASTER LEVEL meter to avoid 
overloading the input signals.
The output level of the stereo mix varies depending 
on the input channel mix balance. To create a mix 
with a wide dynamic range, bring up the STEREO 
fader as high as possible without illuminating the 
OVER LED of the MASTER LEVEL meter.

After you finish shaping the tone of each instrument, set 
the stereo image for each channel and balance the 
overall sound. Sometimes you may want to deliberately 
pan sounds close together, or even right on top of each 
other to emphasize their relationship. There are no hard-
and-fast rules. A good tip is to pan low-range instruments 
and any parts that are very important to the song to the 
center; meanwhile, pan other instruments left and right 
as symmetrically as possible. Normally (but this is not a 
rule) lead vocal, solo instruments, bass, bass drum, and 
snare drums will be panned to the center.

When you are using the n8/n12 as a live SR mixer, if 
you pan the signals or set the stereo balance hard 
left or hard right, the mix may not sound well-
balanced to an audience sitting close to the left or 
right speakers. Use pan and balance with caution 
because mixes will sound different in live SR 
environments and recording environments.

ST
ER

EO
 B

U
S 

L
ST

ER
EO

 B
U

S 
R

INPUT CHANNEL(MONO)

PAN

INPUT A

INPUT B

ST
ER

EO
 B

U
S 

L
ST

ER
EO

 B
U

S 
R

INPUT CHANNEL(STEREO)

BALANCE

R

L

NOTE
Owner’s Manual



A Hands-On Guide to the n8/n12

En
gl

is
h

Applying reverb
Using an effect unit, such as an internal digital reverb, 
can “effectively” add polish to a stereo mix. In this 
example, let’s use the internal digital reverb to apply 
reverb to a stereo mix.
The internal digital reverb uses its dedicated reverb 
bus. Send each input channel signal to the reverb bus 
and adjust the reverb for each channel.
The mixed signal in the reverb bus is then routed to the 
digital reverb. Digital reverb is then applied. You can 
route the output from the digital reverb to the stereo bus 
or other buses.

1. Press the REVERB [TYPE] switch in the Master 
Control section repeatedly to select the desired 
reverb type.

The internal digital reverb provides the following 
three reverb types:

2. Set the [TO AUX], [TO REC], and [TO ST] 
switches on or off to determine the destination of 
the digital reverb output.
You can select multiple destination buses. If the [TO 
ST] switch is turned on, the digital reverb output 
(return signal) will be routed to the stereo bus, thus 
adding reverberation to the stereo mix.

3. Rotate each input channel [REVERB] control 
clockwise to adjust the digital reverb level (send 
level).
You can adjust the digital reverb level using the 
input channel [REVERB] controls. In this example, 
raise this send level high enough so that you will be 
able to listen to and check how much reverb has 
been applied, then fine-adjust the level later.

4. Rotate the REVERB [LEVEL] control in the Master 
Control section left or right to adjust the digital 
reverb output level (return level).
Adjusting the digital reverb output level will adjust 
how much reverb is applied to the entire sound.
A control set to the “▼” position indicates that the 
output level is nominal (0 dB).

5. Rotate the REVERB [LEVEL TIME] control left or 
right to adjust the digital reverb duration (reverb 
time).
As you rotate the control counter-clockwise, the 
digital reverb time gets shorter. As you rotate the 
control clockwise, the reverb time gets longer. 
Adjust the reverb time until you hear the 
reverberation you desire.

6. If necessary, rotate each input channel [REVERB] 
control to fine-adjust the amount of digital 
reverb.

This routing is called “send and return.” It allows one 
effect to be shared by multiple channels. Typically, 
send and return routing is used for reverb and other 
ambient effects.
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NOTE

Select a type.

HALL Simulates reverberation of a concert hall.

ROOM Simulates reverberation of a room.

PLATE Simulates reverberation of a plate echo.

If a monitoring signal is being sent to the players via 
the AUX bus, turning only the [TO AUX] switch on will 
apply reverb to only the monitoring signal, leaving 
the stereo mix without reverb. For example, even if 
you are recording a vocal without reverb, applying 
reverb only to the monitoring signal may help the 
vocalist to sing more easily or get into the “groove.”
In this way, changing the destination of the reverb 
output enables very flexible recording.

Always be careful not to apply too much reverb. Too 
much reverb can tip the mix balance or wash out the 
mix and reduce the overall clarity of the stereo 
image.

NOTE
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Soloing a channel
You can monitor only certain input channel signals. This 
is called the Solo function.
This function is useful when you want to listen to the 
performance or check the sound of only certain input 
channel signals selected from the stereo mix.
The n8/n12 features a dedicated solo bus (L/R), through 
which you can monitor pre-fader or post-fader input 
channels.

■ Soloing a post-fader channel signal
Turn on the [SOLO] switch of the desired input channels 
(the switch indicator(s) will light up).
You can turn on or off the switch for each channel 
individually. For example, you can listen to certain parts, 
such as only bass and drums, or vocal and piano, by 
turning on the [SOLO] switch for multiple desired 
channels.
When the [SOLO] switch is turned on, the monitor 
source for the control room will switch to the solo bus 
and the [C-R SOURCE SELECT] switch indicator will 
flash.

■ Soloing a pre-fader signal
To solo a pre-fader channel signal, turn on the [PFL] 
(Pre-Fader Listen) switch in the Master Control section, 
then turn on the desired input channel [SOLO] switch.
This technique is useful when you want to monitor the 
channel signal without raising the channel fader. If the 
sound seems distorted, you can use this function to 
check whether the signal is already distorted before it 
passes through the fader.

Monitoring a pre-fader signal may surprise you with its 
volume level, which may be much higher than 
expected. Check the monitoring level before you start to 
monitor the pre-fader signal.
On the n12, you can use the [SOLO LEVEL] control in 
the Meter section to adjust the output level of the solo 
bus.

The Solo function is effective on only the monitor 
signal in the control room, and does not affect other 
output signals (such as the stereo bus or AUX bus 
output).
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The n8/n12 features a special function that enables you to link the n8/n12 with Cubase. 
Using this function, you can seamlessly synchronize mixer operation with Cubase, and record and mixdown with 
tremendous efficiency. As an example, this section describes using Cubase 4 with the Link function.

What you can do using the n8/n12 with Cubase

Linking the n8/n12 to Cubase enables you to perform many neat tricks. For example...

■ Controlling Cubase remotely
From the n8/n12 panel, you can remotely control the 
Cubase transport section and set up audio tracks. 

■ Directly recording mixer 
signals to Cubase
You can record input channel signals or REC bus 
signals from the n8/n12 directly into Cubase.
This direct recording capability is very easy and 
convenient.

■ Turning on and off VST or 
other effects applied to the 
monitor signal
From the n8/n12 panel, you can choose whether or 
not you wish to monitor through the mixer the input 
signals processed by VST effects in Cubase. This is 
called the Monitor Remote function. You can easily 
turn this function on or off depending on the 
requirements of your recording environment.
While the Monitor Remote function is turned on, you 
can monitor the input signals processed by the VST 
effects.

■ Mixing Cubase tracks on the 
n8/n12
You can add stereo signals from Cubase audio tracks 
to the mix on the n8/n12, or route each Cubase audio 
track to an individual input channel on the n8/n12.

Using the n8/n12 with Cubase 4/Cubase 
Studio 4/Cubase AI4

You must have Cubase 4, Cubase Studio 4, or Cubase AI4 to use the Link function. Cubase SX3 and Nuendo 3 (and any 
previous version) are not compatible with this feature. For the most recent information on compatibility with the latest version 
of Nuendo, refer to the following website.
http://www.yamahasynth.com/
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Computer setup for the Link function

Follow the steps below to set up your computer so that you can use the Link function.

1. Start the computer.
When the computer is started, make sure that a blue 
driver icon appears on screen.

■ Windows:
The icon in the task bar indicates the driver status.

■ Macintosh:
The icon in the status menu indicates the driver 
status.

2. Connect the n8/n12 to the computer using an 
IEEE 1394 cable, then turn on the power to the 
mixer.
If the software and necessary driver have already 
been installed and the initial settings have been 
made, the setup sequence automatically starts.
During the setup, the driver icon will flash. Wait until 
the icon is lit up steadily.

3. Select [Sample Rate] from the driver icon’s pop-
up menu to display the “Sample Rate” dialog 
box. Then, set the sampling frequency.
To display the menu, right-click the driver’s icon (for 
Windows) or click the driver’s icon ( for Macintosh).

After you select the sampling frequency, click [OK] 
to close the dialog box.

4. Launch Cubase.

■ Windows:
Select [Start] → [All Programs] → [Steinberg Cubase 
4] → [Cubase 4].

■ Macintosh:
Double click [Applications] → [Cubase 4].
If the Yamaha Extension dialog box is displayed 
while Cubase is starting, click [OK].

While Cubase is running, the n8/n12 can be linked to 
Cubase. The CUBASE READY indicator lights up.

Before using the Cubase Link function, you must install special drivers and software, and then make initial settings. For more 
information about installation procedures and initial settings for the dedicated software, please refer to the Installation Guide.

NOTE

A white driver icon means that the driver 
(Connection Manager) is currently disabled. Refer to 
the Installation Guide for information on how to 
enable the driver (Connection Manager).

Caution
While the driver icon is flashing, the computer checks to 
determine whether an IEEE 1394 device is connected. Do NOT 
turn off or on the power to any connected IEEE 1394 device or 
disconnect or connect any IEEE1394 cable while the driver icon 
is flashing.

• (WIndows) If the message “Failed to connect n8/
n12. Do you wish to retry?” appears, click Yes to 
try again. If the same message appears again, 
restart the computer and resume from the 
beginning. If you are still unable to connect, 
execute RESET ALL.

• When you connect the n8/n12 to a computer for 
the first time, the system displays a message 
indicating that connection setup is in progress.

driver icon

driver icon

NOTE

NOTE
If the CUBASE READY indicator does not light up, 
refer to the section related to the CUBASE READY 
indicator in “Troubleshooting” on page 54.

lit

NOTE
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5. Select Device Setup from the Devices tab to 
display the device setup window.

6. In the left column “Devices”, select MIDI, then 
MIDI Port Setup. Then, exclude the MIDI port for 
remote control from the MIDI data inputs.
It is important to exclude the MIDI port for remote 
control from the MIDI inputs. With the settings 
immediately after the installation, controlling the 
Cubase transport section from the n8/n12 will cause 
the transport operation history to be recorded on a 
Cubase MIDI track. To prevent unnecessary MIDI 
messages on a MIDI track, you must exclude the 
MIDI port for remote control from the input track 
options. Refer to the following screens to remove the 
checkmark from the “All Inputs” column in the 
“mLAN MIDI In/n12 (n8) Remote” row.

■ Windows:

■ Macintosh:

After removing the checkmark, click [OK] to close 
the dialog box.

7. Select [File] → [Preferences] to access the 
Preferences dialog box.

Select MIDI Port Setup.

mLAN MIDI In/n12 (n8) Remote column

Remove this checkmark.

• This setting will still be effective the next time you 
start up Cubase. You do not need to re-set this 
setting each time.

• Please refer to the Cubase Operation Guide for 
more information on setting up Cubase 
parameters.

• If you plan to remotely control another DAW, 
exclude the MIDI port for n8/n12 remote control 
from the MIDI inputs.

Select MIDI Port Setup.

mLAN MIDI In/n12 (n8) Remote column

Remove this checkmark.

NOTE
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8. From [Editing], select [Project & Mixer], and in 
the dialog box, make sure that “Sync Project and 
Mixer Selection” is checked.
If this is not checked, click the check box so that a 
check mark appears.
After you have verified this, click [OK] to close the 
dialog box.

9. Select New Project from the File menu to create a 
new project.
The New Project panel opens.

Two templates each are provided for the n8 and 
n12. These templates contain audio I/O and other 
preset data. You can start recording immediately 
after opening one of these templates.

■ Yamaha n12 multi channel recording

■ Yamaha n8 multi channel recording
An individual input channel signal on the n8/n12 will be 
directly routed to each audio track in Cubase.

■ Yamaha n12 stereo recording

■ Yamaha n8 stereo recording
The REC bus signals on the n8/n12 will be routed to the 
Cubase audio tracks.

10. Click the name of the template you wish to use, 
then click [OK].

11. When the directory selection dialog box opens, 
specify a folder in which you wish to store the 
created project file and other audio files. Then 
click [OK].
A project window based on the selected template 
opens.

• If this is not checked, the TRACK CONTROL 
switch of the DAW Remote Control section might 
not operate correctly.

• This setting will be remembered the next time you 
start up Cubase. There is no need to make the 
setting each time.

Verify that
this is checked

Choose [Editing] → 
[Project & Mixer]

NOTE

project templates for n8/n12

• If an n8/n12 project template is not displayed, the 
Extensions for Steinberg DAW may not be 
installed correctly. Refer to the “TOOLS for n/
Cubase AI4 Installation Guide” for instructions on 
installing the software again.

• For more information on the templates, please 
refer to the Appendix.

NOTE
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Using the Link Function

Remotely controlling the 
Cubase transport section and 
audio tracks
From the n8/n12, you can remotely control playback, 
recording, and other Cubase transport operations, as 
well as perform track operations such as selecting 
tracks and operating the Record Enable button.

Remotely adjusting the click 
sound (metronome)
You can turn the Cubase metronome (click sound) on or off, 
and adjust the volume level directly from the n8/n12 panel.

■ Turning the metronome on and off
Press the CLICK REMOTE [ON] switch to turn it on (the 
switch LED lights up).
Turning the metronome on or off on the n8/n12 will also 
turn the Cubase metronome on or off, and vice versa. 
For example, turning the Cubase metronome on will turn 
the CLICK REMOTE [ON] switch on.

■ Adjusting the metronome volume
Rotate the [CLICK LEVEL] knob. As you turn the knob 
clockwise, the volume of the metronome increases. If you 
rotate this knob, then change the level in Cubase, the 
level of the n8/n12 metronome will change accordingly.

Selecting the Work mode
The n8/n12 enables you to select the output destination 
of Cubase audio tracks using just one switch. This 
destination setting is called “Work mode.” The n8 
provides two Work mode options (ST MIX and 
HARDWARE MIX), and the n12 provides three Work 
mode options (ST MIX, HARDWARE MIX, 5.1 MIX).
You can change the Work mode setting at any time as 
appropriate for your situation. For example, you can 
select ST MIX for recording, then change to 
HARDWARE MIX for mixdown.
To select a Work mode, use the WORK MODE switches 
in the DAW Remote Control section.

All WORK MODE switches turn off immediately after the 
mixer is connected to Cubase. When you press one of 
the switches to select a desired Work mode, the 
corresponding output destination is selected in Cubase, 
and the switch LED lights up. The following paragraphs 
describe each Work mode.

■ ST MIX
In this Work mode, all audio tracks are mixed in 
Cubase, then output to the n8/n12 DAW monitor 
channels (n12: L&R, n8: L&R).
To monitor the Cubase signals, turn on the DAW TO ST 
[ON] switch to add output signals from Cubase to the 
mixer’s STEREO buses, then monitor the signals via the 
STEREO buses. If you wish to monitor only the output 
signals from Cubase, turn on the C-R SOURCE SELECT 
[DAW] switch.

If the metronome is not loud enough even after you 
rotate the knob fully clockwise, in Cubase select 
[Transport] → [Metronome Setup], then maximize the 
level of the audio click (or the MIDI click velocity).

track selection

Record Enable button on/off

cycle mode on/off

locating a marker

adding markers

recordrewind
play

stop

fast forward

Adjust the click volume here.

linked
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■ HARDWARE MIX
In this Work mode, the output signal from each Cubase 
audio track is individually input to each n8/n12 input 
channel, then mixed and processed via the compressor 
or equalizer.
When this mode is selected, signals from the DAW 
(DAW inputs) will be sent to all the input channels, and 
the DAW LED in the INPUT SELECT switch area will light 
up.

■ 5.1 MIX 
In this mode, audio tracks are routed to the Cubase 
surround buses. The signals mixed to the surround 
buses can be monitored via the n12 Control Room 
monitor. For more information on surround monitoring, 
refer to page 48.

• You cannot set Work mode to 5.1 MIX if you are 
using Cubase Studio 4 or Cubase AI4, since 
neither application supports the surround 
environment.

• Before you switch Work modes, you must first 
create I/O buses in Cubase so that audio data can 
be transferred between Cubase and the n8/n12. If 
you create a project using one of the n8/n12 
project templates, the I/O buses will be created 
automatically. If you plan to create I/O buses 
manually, refer to the section “Bus connections of 
n8/n12 and DAW” on page 60.

Setting up a musician’s monitor
If the Work mode on the n8/n12 is set to ST MIX, 
Cubase audio tracks will be mixed in the Cubase 
mixer, then output to the n8/n12. If necessary, you 
can make another audio track mix independent from 
the main mix (the mix output to the n8/n12). This 
independent mix can be used as a musician’s 
monitor.
To create a musician’s mix, transfer Cubase audio 
track output directly to the n8/n12 AUX bus by using 
the Cubase mixer send.
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C-R
OUT

ST
OUT

Cubase n8/n12

AUDIO TRACK INPUT CHANNEL
AUDIO TRACK INPUT CHANNEL
AUDIO TRACK INPUT CHANNEL
AUDIO TRACK INPUT CHANNEL

Only

NOTE

In the n8/n12 project templates, each audio track 
send has already been assigned to the n8/n12 AUX 
bus. By adjusting the send level for each audio track 
in Cubase in the same way as when you create a 
musician’s mix by using the n8/n12 [AUX] control, 
you can create a musician’s mix.

If you create a new audio track, or if you create a 
project without using the n8/n12 project templates, 
assign the n8/n12 AUX buses to the audio track 
sends in Cubase.

To transfer signals to the n8/n12 AUX buses from 
Cubase, “n12 (n8) AUX L/R” must be assigned to the 
device (audio) port for the output buses (that are 
assigned to the Cubase audio track sends). The 
assignments in the n8/n12 project templates are as 
follows:

You can adjust the volume of the entire monitoring 
signal either in Cubase or on the n8/n12.
You can use the [DAW TO AUX] control and the 
following controls to adjust the volume of the n8/
n12’s monitor signal.

For the n8
[AUX PHONES] control

For the n12
[AUX PHONES] control and [AUX LEVEL] control

AUX BUS
L R

MIX

DAW TO
AUX

AUX

AUX
PHONE

Cubase

n8/n12

AUDIO TRACK
AUDIO TRACK

AUDIO TRACK

AUDIO TRACK

INPUT
CHANNEL

Only

Output bus n12(n8)-AUX

Device (Audio) port n12(n8) AUX L/R

If you are using Cubase 4, disable Cubase 4’s 
Control Room function.

NOTE
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Let’s start our recording session!

This section will help you understand how to transfer the n8/n12 input channel signals to Cubase and record them on 
the audio tracks.
You can do this in either of the following two ways:

Mixing signals on the n8/n12, 
then recording
The n8/n12 has a dedicated bus (REC bus) that can be 
used to record the mixer signals to a DAW, such as 
Cubase. Using this bus enables you to mix any input 
channel signals on the n8/n12, then record them in 
Cubase.
This example here uses the Monitor Remote function to 
monitor the VST effect signals while recording signals 
via the REC bus.

■ Preparing for recording

1. Press the INPUT SELECT [A.IN] switch to turn it 
on (analog input).
While Cubase is linked to the mixer, you can select 
the input source by using the INPUT SELECT 
switches. While the INPUT SELECT [A. IN] switch is 
turned on, analog input can be selected as the input 
source. While the INPUT SELECT [DAW] is turned on, 
Cubase (DAW) output signal can be selected as the 
input source. Typically, you will select analog input 
for recording, and select DAW when you wish to mix 
the recorded signals in Cubase using the n8/n12.

2. Connect musical instruments and microphones 
to the mixer’s input channels, then adjust the 
gain and pan.
For details, see “A Hands-On Guide to the n8/n12” 
on page 24 to 32.

3. Turn on the [REC] switches for the channels you 
wish to record. (The switch LEDs light up.)
If you turn on the channel [REC] switches, the 
corresponding input channel signals will be routed 
to the REC bus. At this time, the pan and volume 
balance of each input channel will be used.

4. On Cubase, select the audio track on which you 
wish to record, and then select “n12 (n8)-REC” as 
the input routing by clicking it.
The input source and output destination of the track 
will be displayed in the Inspector located to the left of 
the track list. You can select the input source for the 
audio track by clicking an input routing option.
If you select “n12(n8)-REC,” the REC bus signals will 
be input to the corresponding audio track.

If you select the “Yamaha n12 (n8) stereo recording” 
project template, the REC bus will be automatically 
selected as the input source for each audio track.

Cubase

n8/n12

ST
ER

EO
 B

U
S 

L
ST

ER
EO

 B
U

S 
R

R
EC

 B
U

S 
L

R
EC

 B
U

S 
R

INPUT
CHANNEL

AUDIO
TRACK

AUDIO
TRACK

AUDIO
TRACK

INPUT
CHANNEL

NOTE

• To select a track in Cubase, you can use the 
[PREV ▲] and [NEXT ▼] switches in the DAW 
Remote Control section on the n8/n12.

• If the track’s input/output routing is not displayed, 
click the [Show Inspector] button.

Turn this on (LED lights up).

input source of audio track
(Input Routing)

NOTE

Show Inspector
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5. Make sure that the Record Enable button is on 
(red) for the recording destination audio track in 
Cubase. If it is off, press the [REC READY] switch 
in the DAW Remote Control section to turn on the 
Record Enable button.
The REC bus signals will be sent to the 
corresponding audio track. If you want to record the 
signals without any VST effect being applied, 
proceed to Step 10.

■ Setting the Monitor Remote 
function

If you wish to monitor the REC bus signals processed 
by a VST effect, follow steps 6 to 9 below.

6. Make settings in Cubase to insert the VST effect 
on the input bus or audio track.

7. Turn the MONITOR REMOTE [ON] switch on (the 
switch LED lights up).
The Monitor Remote function is activated.

8. Turn the MONITOR REMOTE [REC BUS WET] 
switch on (the switch LED lights up).
Turning the MONITOR REMOTE [REC BUS WET] 
switch on turns the Cubase monitoring button on as 
well. When the both switches are on, you can 
monitor the signal with the VST effect applied (the 
“wet” sound).

9. Turn the DAW TO ST [ON] switch on ( ).
While the Record Enable button and monitoring button 
are turned on, the REC bus monitoring signal will be 
returned to the n8/n12 via the Cubase mixer. When you 
turn the DAW TO ST [ON] switch on, the monitoring 
signal returned from Cubase will be routed to the 
STEREO buses, enabling you to monitor the signal.

■ Recording

10. Press the [REC] switch to start recording.

11. Play the instruments.

12. When you finish playing the instruments, press 
the [■] switch to stop recording.

13. To review the recorded result, press the [ ] 
switch or [ ] switch to return to the beginning 
of the project, then press the [ ] switch.

If you wish to turn on the Record Enable button for 
multiple tracks by using the [REC READY] switch, 
make the following settings in Cubase.
(1) Open the [Preferences] dialog box by selecting 

[File] → [Preferences] (for Windows), or by 
selecting [Cubase] → [Preferences] (for Macintosh).

(2) Select [Project & Mixer] from the [Editing] menu.
(3) Remove the check from the “Enable Record on 

Selected Track” check box in the dialog box.
(4) Click [OK] to close the dialog box.

on on

monitoring 
button

While you are using the Monitor Remote function, the 
input channel signals being sent to the REC buses 
will temporarily be disconnected from the STEREO 
bus so that they will not be doubled in the monitor 
sound; this allows you to monitor the signal that is 
being routed through Cubase. While the Monitor 
Remote function is active, the corresponding input 
channel’s [ST] switches flash. If you deactivate the 
Monitor Remote function, the [ST] switches stop 
flashing. 

To activate the Monitor Remote function, first turn the 
Record Enable buttons on, then turn the MONITOR 
REMOTE [ON] switch and [REC BUS WET] switch 
on.

STEREO
BUS
L R

REC
BUS
L R

C-R OUT

DAW TO
ST

Cubase

n8/n12

INPUT
CHANNEL

INPUT
CHANNEL AUDIO TRACK

AUDIO TRACK

• Processing the signals via the VST or other 
effects may cause latency in the monitoring 
signal.

• While the Monitor Remote function is active, 
the effect signals will be directly routed to the 
AUX output. Therefore, the [AUX] control for 
the corresponding input channels will be 
disabled. If you wish to adjust the monitoring 
balance between the instruments, adjust the 
level in Cubase.

NOTE
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Recording n8/n12 input channel 
signals directly to Cubase
Each input channel signal can be output and recorded to 
a Cubase audio track individually. This section will help 
you understand how to record a signal from input channel 
1 directly to a Cubase audio track while using the Monitor 
Remote function to monitor the VST effect signals.

■ Preparing for recording

1. Press the INPUT SELECT [A.IN] switch to turn it 
on (analog input).

2. Connect a musical instrument or a microphone to 
the mixer’s input channel 1, then adjust the gain.
For details, see “A Hands-On Guide to the n8/n12” 
on page 24 to 25.

3. Select an audio track on which you wish to 
record the signal, then select “n12(n8)-Dir1” for 
input routing by clicking it.
The input source and output destination of the track 
will be displayed in the Inspector located to the left 
of the track list.
If you select “n12(n8)-Dir1,” the channel 1 signal will 
be input to the specified audio track.

You can select the input source from the following 
options:

■ n12

* Options in parentheses can be selected only for 
monaural tracks.

■ n8

* Options in parentheses can be selected only for 
monaural tracks.

4. Press the [REC READY] switch in the DAW 
Remote Control section; the Record Enable 
button in Cubase will be turned on for the audio 
track on which you are recording.
The REC bus signals will be sent to the specified 
audio track. If you want to record the signals without 
a VST effect being applied, proceed to Step 9.

The pre-fader signal will be sent to the audio track. 
When using this method of recording (n8/n12 input 
channel signals directly to Cubase), the channel 
fader and other channel controls will be disabled.

If you select the “Yamaha n12 (n8) multi channel 
recording” project template, the direct output from 
the input channel will be automatically selected as 
the input source for each Cubase audio track.

INPUT A

INPUT CHANNEL

INPUT B

n8/n12 Cubase

COMP EQ

audio track

input source of audio track
(Input Routing)

NOTE

• To select a track in Cubase, you can use the 
[PREV ▲] and [NEXT ▼] switches in the DAW 
Remote Control section on the n8/n12.

• If the track’s input/output routing is not displayed, 
click the [Show Inspector] button.

Input routing Input source

n12-REC(Left/Right) REC bus

n12-ST(Left/Right) STEREO bus

n12-Dir1–n12-Dir8 Monaural input 
channel direct output

n12-Dir9/10, n12-Dir11/12
(Left/Right)

Stereo input channel 
direct output

Input routing Input source

n8-REC(Left/Right) REC bus

n8-ST(Left/Right) STEREO bus

n8-Dir1–n8-Dir4 Monaural input 
channel direct output

n8-Dir5/6, n8-Dir7/8 
(Left/Right)

Stereo input channel 
direct output

NOTE
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■ Setting the Monitor Remote 
function

If you wish to apply a VST effect to the input channel 1 
signal and monitor the effect signal, follow steps 5 to 7 
below.

5. Insert the desired VST effect in the Cubase input 
bus to which input channel 1 is being sent, or 
insert it into the audio track.

6. Turn the MONITOR REMOTE [ON] switch on (the 
switch LED lights up).
When the MONITOR REMOTE [ON] switch is on, the 
Monitor Remote function is active.

7. Turn the input channel 1 [WET] switch on (the 
LED will light).
Turning the Input Channel [WET] switch on turns the 
Cubase monitoring button on as well. When the both 
switches are on, you can monitor the signal with the 
VST effect applied (the “wet” sound).

8. Turn the DAW TO ST [ON] switch on ( ).
While the Record Enable button and monitoring 
button are turned on, the monitoring signal will be 
returned to the n8/n12 via the Cubase mixer. When 
you turn the DAW TO ST [ON] switch on, the 
monitoring signal returned from Cubase will be 
routed to the STEREO buses, enabling you to 
monitor the signal.
If you wish to listen to the effect signal only in the 
control room, turn on the C-R SOURCE SELECT 
[DAW] switch to select DAW (Cubase) as the 
monitoring source.

■ Recording

9. Press the [REC] switch to start recording.

10. Play the instrument.

11. When you finish playing the instrument, press 
the [■] switch to stop recording.

12. To review the recording result, press the [ ] 
switch or [ ] switch to return to the beginning 
of the project, then press the [ ] switch.

monitoring button

If the input channel signal had been routed to the 
STEREO bus, the input channel signal being sent to 
Cubase will temporarily be disconnected from the 
STEREO bus so that it will not be doubled in the 
monitor sound. While the signals are disconnected, 
the corresponding input channel’s [ST] switches 
flash. If you deactivate the Monitor Remote function, 
the [ST] switches stop flashing.
To activate the Monitor Remote function, first turn the 
Cubase Record Enable buttons on, then turn the 
MONITOR REMOTE [ON] switch and the Input 
Channel [WET] switches on. 

• If the [WET] switches for multiple input channels 
have been turned on, turning off the MONITOR 
REMOTE [ON] switch will turn off all channel 
[WET] switches.

• Processing the signals with VST effects may 
cause latency in the monitoring signal.

• While the monitor remote function is active, the 
signal with the VST effect applied will be sent 
directly to the AUX output. This means that the 
[AUX] control of the corresponding input channel 
will temporarily be disabled. If you want to adjust 
the monitor balance, you can do so within 
Cubase.

NOTE
Owner’s Manual
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Mixing recorded tracks

You can easily monitor tracks recorded in Cubase by mixing them on Cubase and setting the n8/n12's C-R SOURCE 
SELECT switch to DAW. If you wish to use the n8/n12's compressor and reverb, you can mix tracks using the n8/n12. 
This section describes how to send recorded audio track data from Cubase to the n8/n12 input channels, and then mix 
them to stereo.

Mixing audio tracks
1. If the Monitor Remote function is active, turn the 

MONITOR REMOTE [ON] switch off to disable the 
Monitor Remote function.

2. If any audio tracks’ Record Enable buttons are 
on, turn these buttons off.

3. Set the STEREO fader to the “0” position, then 
make sure that the STEREO [ON] switch is turned 
on.

4. Turn on the [HARDWARE MIX] switch in the DAW 
Remote Control section (the switch LED lights up).
When the switch is turned on, the input source for all 
input channels is switched to DAW (Cubase audio 
tracks). 

When you set the Work mode to HARDWARE MIX, 
the audio track outputs will be assigned to channels 
in the order of their track number.

■ n12

■ n8

5. If necessary, click the audio track output routing 
menu, and change the output destination.

INPUT CHANNEL

INPUT CHANNEL

INPUT

n8/n12

Cubase

PAN

COMPA/D

S
TE

R
E

O
B

U
S

EQ

AUDIO TRACK

AUDIO TRACK

track numbers

Cubase track # Output to (n12 input channel)

Track 1 n12-1

Track 2 n12-2

Track 3 n12-3

Track 4 n12-4

Track 5 n12-5

Track 6 n12-6

Track 7 n12-7

Track 8 n12-8

Track 9 n12-9/10

Track 10 and higher n12-11/12

Cubase track # Output to (n8 input channel)

Track 1 n8-1

Track 2 n8-2

Track 3 n8-3

Track 4 n8-4

Track 5 n8-5/6

Track 6 and higher n8-7/8

While the Work mode is set to HARDWARE MIX, 
you can select analog inputs (A. IN) as the input 
source for the input channels. This is convenient if 
you wish to add analog input signals to the mix.

NOTE

audio track output 
destination
(Output Routing)
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Use one of the following three methods to route 
Cubase audio tracks to the n8/n12.

■ Assign each audio track to an input channel 
individually
This method is useful when you want to mix a solo 
part or other important parts.

■ Assign multiple audio tracks to the same input 
channel
In this case, multiple audio tracks will be mixed in 
the Cubase mixer, then routed to the n8/n12 input 
channel.
This method is useful when you want to first create a 
mix from multiple tracks, such as drums recorded on 
multiple tracks.

■ Select the “n12 (n8)-L/R” output routing option, 
then mixing signals via DAW TO ST.
If you turn the DAW TO ST [ON] switch on, you can 
use DAW TO ST as the input channel.

6. Use the Cubase mixer control to adjust the 
output level of the audio tracks.

■ If you are assigning each audio track to an input 
channel individually:
In the Cubase mixer, set the fader (for the track you 
wish to assign) to the “0.00” position. With this 
setting, the signal will be routed to the input channel 
at the nominal output level.

■ If you are assigning multiple audio tracks to the 
same input channel:
In the Cubase mixer, adjust the mix balance 
between the tracks.

7. While playing back the Cubase project, control 
the channel faders to adjust the mix balance.
If the signals are being mixed to the STEREO buses 
via DAW TO ST, rotate the DAW TO ST [LEVEL] 
control to adjust the signal level.
You can also apply the n8/n12 built-in digital reverb 
to the audio track playback signal by turning on the 
REVERB TO ST [ON] switch and rotating the channel 
[REVERB] control.

AUDIO TRACK INPUT CHANNEL

INPUT CHANNELAUDIO TRACK

Cubase n8/n12

AUDIO TRACK INPUT CHANNEL

INPUT CHANNELAUDIO TRACK

Cubase n8/n12

ST
ER

EO
B

U
S

AUDIO TRACK

AUDIO TRACK

INPUT
CHANNEL

INPUT
CHANNEL

Cubase n8/n12

DAW TO ST
on
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Mixing down
Finally, mixdown time! Now you can record the 
completed mix onto stereo tracks. This section explains 
how to do so.

1. Select [Project] → [Add tracks] → [Audio].
The Add Audio Track dialog box opens.

2. Click the Configuration column to select 
“stereo,” then click [OK].

A new stereo track is created.

3. Select the created stereo track, then turn the 
Record Enable button on.

4. Click the input routing option to select “n12 (n8)-
ST.”
The STEREO bus signal of the n8/n12 will be input to 
the new stereo track in Cubase.

5. If the Cubase track outputs are routed to the n8/
n12 STEREO buses via DAW TO ST, turn off the 
DAW TO ST [ON] switch.
If the DAW TO ST [ON] switch is on during mixdown, 
an audio loop will be created, producing a very loud 
noise. Be sure to turn off the DAW TO ST [ON] 
switch before you start mixdown.

6. Press the [ ] switch or the [ ] switch to 
locate the top of the project.

7. Press the [REC] switch to start mixdown.
The project starts playing from the beginning, and 
the signals being mixed on the n8/n12 in real time 
will be recorded to the new stereo track.

8. When you have finished recording, press the [■] 
switch to stop the playback.

9. To review the recording, click the solo state 
button to turn it on, then use the [ ] or [ ] 
switch to return to the beginning of the project, 
then press the [ ] switch to listen to the 
recording.

INPUT CHANNEL

INPUT CHANNEL

INPUT CHANNEL

INPUT CHANNEL

AUDIO TRACK

AUDIO TRACK

AUDIO TRACK

AUDIO TRACK

AUDIO TRACK

Cubase n8/n12

Cubase n8/n12
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INPUT CHANNELAUDIO TRACK

INPUT CHANNELAUDIO TRACK

INPUT CHANNELAUDIO TRACK

INPUT CHANNEL

AUDIO LOOP

AUDIO TRACK

AUDIO TRACK

mixdown tracks
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The n12 features a Surround Monitor function that enables you to easily monitor your mix in Cubase 4 5.1-channel 
surround sound. This section describes how to use the Surround Monitor function.

Connecting surround 
speakers

Connect each surround channel speaker to C-R OUT 
jacks A-C.
Each jack is assigned to the following channel speaker:

C-R OUT jack A (L) .......L channel speaker
C-R OUT jack A (R) .......R channel speaker
C-R OUT jack B (L) .......Center channel speaker
C-R OUT jack B (R) .......Subwoofer
C-R OUT jack C (L) .......L surround channel speaker
C-R OUT jack C (R) .......R surround channel speaker

Placement of the 
surround speakers

Speaker position is extremely important to accurate 
monitoring in a surround sound environment. Refer to 
the description below to place your speakers.

L/R channel speakers
Place your L & R speakers so that they form an 
equilateral triangle, with your listening position as the 
third point. (All three sides should be the same length, 
and all three interior angles should be 60˚).

LS/RS channel speakers
Place your LS & RS speakers so that they are in about 
the 4 o’clock and 8 o’clock positions (100 - 120˚ angle 
from the center.)

Center channel speaker
Determining where to place the center channel speaker 
is easy. Simply place it between the L and R channel 
speakers. If possible, place it slightly further away from 
the listening position than the L and R channel 
speakers. In other words, if you were to draw a line 
between the L and R speakers, the center speaker 
should be positioned a little beyond that line.

Subwoofer (LFE channel)
Place your subwoofer the same distance from the 
listening position as the other speakers, and on the floor 
between the L and R channel speakers. Since a 
subwoofer typically features a wide projection angle, 
shifting its position to the left or right will not affect the 
sound you hear.

Monitoring in a Surround Sound Environment 
(n12 only)

Cubase 4 is required in order to use the surround monitor functionality. The included Cubase AI4 does not support surround 
monitoring, and cannot use the surround monitor functionality.

NOTE

L
(LEFT)

R
(RIGHT)

LS
(LEFT SURROUND)

RS
(RIGHT SURROUND)

SW
(SUBWOOFER)

C
(CENTER)

listening point

R

C SW

RSLS

L

100–120˚ 100–120˚

30˚ 30˚
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Setting up surround monitoring

1. Turn on the [5.1 MIX] switch in the DAW Remote 
Control section (the switch LED lights up).
The n12 switches Work mode to 5.1-ch surround. 
Cubase 4 selects “n12-5.1” as the destination of its 
audio tracks.

2. Turn on the [5.1] switch in the Control Room 
section (the switch LED lights up).
5.1-ch Cubase 4 signals will be adjusted by the 
Bass Management function, then input to the Control 
Room Monitor section, and output to the speakers.
You can adjust the monitoring level using the 
[CONTROL ROOM LEVEL] control.

3. If you wish to mute certain surround channel 
signals, press the corresponding C-R SPEAKER 
SELECT switches.
Pressing any C-R SPEAKER SELECT switch during 
surround monitoring will mute the corresponding 
surround channel. Pressing any C-R SPEAKER 
SELECT repeatedly will cycle the corresponding 
switch LED status as follows: lights up solid → 
flashing fast → flashing slow → off. The following table 
can help you select the channel you wish to mute.

4. To cancel surround monitoring, use the C-R 
SOURCE SELECT switches to select any monitor 
source other than 5.1 channel.

For more information on surround mixing using Cubase 
4, please refer to the Cubase 4 Owner’s Manual.

Lit Flash 
(fast)

Flash 
(slow) Off

C-R 
SPEAKER 
SELECT 

[A] switch

L & R: 
output

L: output
R: mute

L: mute
R: output

L & R: 
mute

C-R 
SPEAKER 
SELECT 

[B] switch

C & SW: 
output

C: output
SW: mute

C: mute
SW: output

C & SW: 
mute

C-R 
SPEAKER 
SELECT 

[C] switch

Ls & Rs: 
output

Ls: output
Rs: mute

Ls: mute
Rs: output

Ls & Rs: 
mute
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Bass Management function
In a surround sound system that includes a 
subwoofer, the bass components of all channels and 
the LFE channel signal are output to the subwoofer. 
Bass Management is a function that makes 
adjustments in order to prevent interference between 
the signals sent to the subwoofer and the signals sent 
to the other speakers.
While you are using the n12 Surround Monitor 
function, the Bass Management function works as 
illustrated in the diagram below.

Surround downmix
If necessary, you can monitor the sound in stereo by 
mixing the surround signals into two channels during 
surround monitoring. This is called a “surround 
downmix.”
To downmix the signals during surround monitoring, turn 
on the [DOWN MIX] switch in the Control Room section. 
The LS, RS, C, and LFE channel signals will be split to L 
and R channels, then output from the C-R OUT jack A. 
Meanwhile, the level of these channel signals will be 
automatically adjusted so that the monitoring level will 
not change. Press the [DOWN MIX] switch again to 
cancel the downmix and restore the surround signals.

• During surround monitoring, the C-R PHONES 
jack always output downmix signals.

• You can turn on the [5.1] switch and the [ST] 
switch in the Control Room section simultaneously. 
In this way, you can mix together the surround L 
and R channel signals and the L and R signals in 
the STEREO buss, then output them to the monitor 
speakers. If the DAW TO ST [ON] switch has been 
turned on, turning on the [5.1] and [ST] switches 
together at the same time will turn off the [ON] 
switch (the switch LED flashes).

HPF

HPF

HPF

LPF AMP

HPF

HPF

LPF

L
(DAW IN 1)

R
(DAW IN 2)

C
(DAW IN 3)

LFE
(DAW IN 4)

LS
(DAW IN 5)

RS
(DAW IN 6)

LPF=100Hz, -12dB/Oct
HPF=100Hz, -12dB/Oct

L

R

C

SW

LS

RS

AMP=+10dB

DOWNMIX L

DOWNMIX R

L
(DAW IN 1)

R
(DAW IN 2)

C
(DAW IN 3)

LFE
(DAW IN 4)

LS
(DAW IN 5)

RS
(DAW IN 6)

ATT

ATT

ATT

ATT ATT = –3 dB attenuator

NOTE
Owner’s Manual 47



Replacing the Sweet Spot Data

48

En
gl

is
h

You can replace the n8/n12’s compressor settings (Sweet Spot Data) by using a dedicated software application called 
Sweet Spot Data Manager. This application contains several Sweet Spot Data sets and enables you to easily replace 
(load) the data while the n8/n12 is operating. For example, you can apply compression using the preset data while 
recording, and use other data while mixing.
Download the Sweet Spot Data Manager from the following URL.
http://www.yamahasynth.com/download/
Double-click the Sweet Spot Data Manager icon, and install the program as directed in the screen. For details on the 
installation, refer to the installation guide included with the application.
Follow the steps below to load the Sweet Spot data on your n8/n12.

1. Make sure that the n8/n12 is connected to a 
computer via an IEEE 1394 cable, and is 
operating normally.

2. Start Sweet Spot Data Manager.

■ Windows:
From the Start menu, select [All Programs] → [Sweet 
Spot Data Manager] to start the application. 
Alternatively, double-click the Sweet Spot Data 
Manager short-cut icon on the desktop.

■ Macintosh:
Double click [Applications] → [Yamaha] → 
[SweetSpotDataManager] → [SSDManager] to start 
the application.
When the application starts up, the following screen 
will appear.

If the n8/n12 is connected to a computer correctly, 
the UPDATE button will be highlighted in color. The 
current, loaded data on the n8/n12 will be listed in 
the Current Data column.

3. In the Sweet Spot Data list, click the name of a 
Sweet Spot Data set that you wish to load on the 
n8/n12.
You can sort the list by No, Name, Author, 
Description or Note by clicking the corresponding 
column title.

4. To load the selected data on the n8/n12, click the 
UPDATE button.
It takes only a few seconds to load the data. When 
the load operation is complete, you can use the new 
Sweet Spot data immediately.

Replacing the Sweet Spot Data

• Before using the Sweet Spot Data Manager, make 
sure that the n8/n12 is connected to a computer 
correctly, and that the application software, 
including the driver software, has been installed 
correctly.

• To avoid malfunction, connect the n8/n12 to a 
computer directly, without any other devices 
connected to either machine.

If an error message is displayed, check that the 
cable is correctly connected, and that the driver and 
other required software is installed correctly. Then 
restart the application.

NOTE

Sweet Spot Data list

UPDATE button

Current Data column

NOTE

You can enter comments in the Note column. For 
example, if you enter a number in the Note column 
for each data, you can sort the list by number by 
clicking the column entitled Note.

During the load operation, the n8/n12 output signals 
will be muted.

To return the Sweet Spot data to the factory-set state, 
select “0 Preset” in the Sweet Spot Data list and click 
the UPDATE button.

No. column: 
data number

Description column: 
explanation of the data

Author column: 
creator

Note column: 
comment field

Name column: 
Sweet Spot 
Data name

NOTE

NOTE
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You can use the n8/n12 with other DAWs in addition to Cubase, as well as multimedia applications such as Windows 
Media Player. To do so, follow the procedure below:

Using the n8/n12 with a DAW other than Cubase

If you are using a typical DAW (other than Cubase), you 
will be able to do the following.

• Input and output audio signals
• Input and output MIDI messages
• Use remote control to operate the DAW

Audio Driver Setup
■ Input and output audio signals
The signals from the n8/n12 can be recorded on the 
audio tracks of your DAW, and the audio tracks’ 
playback signals can be mixed on the n8/n12. Select 
“ASIO mLAN”/“mLAN Audio OUT” (for Windows) or 
“mLAN Network” (for Macintosh) on the audio driver 
setup window for your DAW software, then set the n8/
n12 audio input/output ports as follows.

MIDI Driver Setup

■ Input and output MIDI messages
DAW software displays the MIDI I/O connectors on the 
rear panel of the n8/n12 as follows:

■ Remote control of the DAW
You can use the switches in the DAW Remote Control 
section (as shown below) to remotely control DAWs 
other than Cubase.

To remotely control your DAW from the n8/n12, make 
the following settings in the DAW:

Using the n8/n12 with Software Other Than 
Cubase

A dedicated driver (Yamaha AI Driver) must already be installed and set up properly.NOTE

For information on setting up your DAW, refer to the 
DAW owner’s manual.

● SONAR 5 (with ASIO driver)

DAW → n8/n12 n8/n12 → DAW

n12 ASIO mLAN mLAN01– 
ASIO mLAN mLAN15

Left ASIO mLAN mLAN01 – 
Right ASIO mLAN mLAN15

n8 ASIO mLAN mLAN01– 
ASIO mLAN mLAN11

Left ASIO mLAN mLAN01 – 
Right ASIO mLAN mLAN11

● SONAR 5 (with WDM/KS driver)

DAW → n8/n12 n8/n12 → DAW

n12 mLAN Audio Out 1/2– 
mLAN Audio Out 7/8

n8 mLAN Audio Out 1/2 – 
mLAN Audio Out 7/8

If you are using the WDM/KS driver, only eight 
channels can be output from your DAW to the n8/n12.

● Logic Pro7

DAW → n8/n12 n8/n12 → DAW

n12 Output 1–Output 16 Input 1–Input 16

n8 Output 1–Output 12 Input 1–Input 12

● D.P.5

DAW → n8/n12 n8/n12 → DAW

n12 mLAN Network:Audio In1 1–
mLAN Network:Audio In16 16

mLAN Network:Audio Out1 1–
mLAN Network:Audio Out16 16

n8 mLAN Network:Audio In1 1–
mLAN Network:Audio In12 12

mLAN Network:Audio Out1 1–
mLAN Network:Audio Out12 12

NOTE

NOTE

If you are using D.P.5, you will need to connect the 
MIDI drivers to the MIDI input/output plugs of 
external devices from the “Audio MIDI Setup” 
window. Refer to page 50.

MIDI ports that correspond to the n8/n12 MIDI I/O 
connectors

Windows
Input mLAN MIDI In (2)

Output mLAN MIDI Out (2)

Macintosh
Input n12:2 (n12) n8:2 (n8)

Output n12:2 (n12) n8:2 (n8)

The Mackie Control “USER SWITCH (A)” function is 
assigned to the foot switch. If you prefer, you can 
assign another function to the foot switch from the 
DAW.

Type of remote controller

Mackie Control

MIDI ports used for connecting the remote controller

Windows
Input mLAN MIDI In

Output mLAN MIDI Out

Macintosh
Input n12:1 (n12) n8:1 (n8)

Output n12:1 (n12) n8:1 (n8)

Logic Pro 7 automatically recognizes it as the 
Mackie Control settings when the n8/n12 is 
connected to your computer.

NOTE

rewind
fast forward

stop

play
record

NOTE

NOTE
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For Digital Performer Users
To input and output the MIDI signals with D.P.5, you 
will need to set the MIDI driver.

1. Select [Application] → [Utilities] → [Audio MIDI 
Setup] to display the “Audio MIDI Setup” 
window.
The MIDI driver is shown as “mLAN Network.”

2. Click [Add Device] twice to add two external 
devices.

3. Connect the input/output plugs for the MIDI 
driver to those for the new external devices.

This setting may be unnecessary for the latest 
version of your DAW software.

NOTE
Owner’s Manual
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Using the n8/n12 along with a multimedia application

To use the n8/n12 with a multimedia player such as Windows Media Player or Quick Time Player, you must make the 
following settings:

■ Windows:

1. From the Start menu, select [Settings] → [Control 
Panel] → [Sounds and Audio Devices]
The Sounds and Audio Devices dialog opens.

Click the Audio tab in the dialog, then select “mLAN 
Audio Out” as the Default device for the Sound 
Playback column.

2. Click [Apply] to apply the settings, then click 
[OK] to close the dialog.

3. Turn on the C-R SOURCE SELECT [DAW] switch 
on the n8/n12, then adjust the monitoring level 
for the control room.

■ Macintosh:

1. From the Apple menu, select [System 
Preferences...] to display the “System 
Preferences” window.

2. Click [Sound] on the window.

3. Click [Output], then select “mLAN Network” in 
the “Choose a device for sound output” field.
After you select “mLAN Network”, close the window.

4. Select [Applications] → [Utilities] → [Audio MIDI 
Setup] to display the “Audio MIDI Setup” window.

5. Click [Audio Devices] and check whether “mLAN 
Network” is selected for “Default Output:” and 
“Properties For:.”
 Then, click [Configure Speakers].
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6. Select [Stereo], then click [Apply].
After making the setting, click [Done] and close the 
“Audio MIDI Setup” window.

7. Turn on the C-R SOURCE SELECT [DAW] switch 
on the n8/n12, then adjust the monitoring level 
for the control room.

■ Surround monitoring 
If your computer has software that is capable of 5.1 
surround playback (such as a DVD player application), 
you can monitor 5.1-ch surround signals by connecting 
surround monitor speakers to the n12.

■ Windows:

1. From the Start menu, select [Settings] → [Control 
Panel] → [Sounds and Audio Devices].
The Sounds and Audio Devices dialog opens.

2. Click the Audio tab in the dialog, then select 
“mLAN Audio Out” as the default device in the 
Sound Playback column.

3. Click Advanced in the Sound Playback column to 
display the Advanced Audio Properties.

4. Click the Speakers tab, then select “5.1 surround 
sound speakers.”

Click [OK] to close the dialog.

5. In the software you are using, select 5.1-ch 
surround as audio output.
For more information on how to set up the software, 
refer to the owner’s manual or on-line help for the 
software application.

6. Turn on the C-R SOURCE SELECT [5.1] switch on 
the n12 to adjust the monitoring level for the 
control room.

For more information on how to set up playback 
software, such as Windows Media Player, refer to 
the owner’s manual for the software or to its on-line 
help.

NOTE

If you are using Windows Media Player, you must 
purchase a surround decode plug-in. For more 
information regarding purchasing and setting the 
decode plug-in, contact the manufacturer of the 
software you are using.

Only

NOTE
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While using the mixer

■ No sound is heard, or the sound is too faint.
• The cable that connects the mixer and the external 

device may be damaged.
• Make sure that a signal from an external device or 

the DAW is being sent to the n8/n12's input.
• The volume of all connected tone generators and 

playback devices must be set to an appropriate level.
• The gain must be set to an appropriate level.
• If you are connecting a condenser microphone, 

the Phantom [+48V] switch must be turned on.
• If you are connecting an electric guitar, make sure 

that it is connected to an input jack that supports 
Hi-Z, and that the [Hi-Z] switch is turned on.

• Make sure that the INSERT I/O connectors are 
connected properly.

• Make sure that each channel [ON] switch is turned 
on.

• Is the [ST] switch of each channel turned on 
(assignment to the STEREO bus = enabled)?

• Each input channel fader must be raised to an 
appropriate level.

• The [CONTROL ROOM LEVEL] knob and the [C-R 
PHONES] knob must be set to an appropriate level.

• Make sure that the speakers or headphones are 
connected correctly.

• Make sure that the power to your amplifier and 
other external devices is turned on.

• Make sure that the volume between monitor 
speakers is well-balanced.

■ Sound is distorted.
• The cable that connects the mixer and the external 

device may be damaged.
• The gain must be set to an appropriate level.
• If high-level signals are being input, the 

corresponding channel [PAD] switches must be 
turned on.

• The [Drive] control for the compressor may be set 
excessively high. Set the control to an appropriate 
level.

• The EQ gain may be set excessively high. Set the 
control to an appropriate level.

• The faders for an input channel, stereo input 
channel, or stereo output channel may be raised 
excessively. Set all faders to an appropriate level.

■ Noise.
• There may be a noise-producing device (such as 

a device containing a power inverter, etc.) near 
the cables. Move all cables away from any 
possible sources of noise.

■ Cannot use the built-in digital reverb.
• Be sure to adjust the input channel [REVERB] 

control to send the signal to the built-in digital 
reverb.

• Make sure that the output from the digital reverb is 
appropriately assigned.

• The REVERB [LEVEL] control must not be set to 
“0.”

While using the mixer with a computer

■ No sound is heard, or the sound is too faint.
• The volume settings within your application must 

be set to appropriate levels.
• Make sure that the driver (Connection Manager) is 

enabled. (The driver icon should be blue.)
(Windows) Right-click the driver icon on the task 
bar then select [ON].
(Macintosh) Click the driver icon on the status 
menu, then select [Connection Manager] → [ON].

■ The sound is distorted.
• Make sure that audio was recorded at an 

appropriate level.

■ Noise is heard in the computer audio
• The IEEE 1394 cable may be damaged. Cables 

that do not satisfy IEEE1394 (S400) standards may 
cause noise.

• There may be a noise-producing device (such as 
a device containing a power inverter, etc.) near 
the IEEE1394 cable. Move all cables away from 
any possible sources of noise.

• Make sure your computer satisfies the system 
requirements.

• Make sure that the latency setting of the driver is 
appropriate.

• Make sure that the sampling frequency is 
appropriate. A high sampling frequency may be 
the cause of noise, depending on the computer’s 
capacity and speed.

• If your computer’s hard disk is slow, problems 
may occur during recording and playback.

• Try increasing the computer’s memory capacity.
• Quit all applications that are running in the 

background, when you use the n8/n12 with the 
computer. If such software is running, driver 
operation may become unstable and create noise.

• (Windows) Some Intel mobile CPUs feature EIST 
(SpeedStep) technology. If you are using the n8/
n12 along with such a computer, disable the EIST 
(SpeedStep) technology function. Most computers 
allow you to disable this in the BIOS. For more 

Troubleshooting
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information, refer to the owner’s manual for the 
computer, or contact the manufacturer of the 
computer.

• (Windows) Some network adaptors can cause 
noise. In such a case, use the Device Manager to 
disable the suspected network adaptor to remove 
the noise.

■ The CUBASE READY indicator does not turn on. / 
Cubase cannot be remotely controlled.
• Make sure that the Extensions for Steinberg DAW 

software has been installed properly.
• Make sure that the n8/n12 is connected to the 

computer via an IEEE 1394 cable.
• You must use Cubase 4, Cubase Studio 4, or 

Cubase AI4. Cubase SX3 and Cubase versions 
older than version 4 do not support the Link function.

• From the Devices menu, select Device settings to 
open the Cubase Device Settings panel, then 
make sure that “Yamaha n 12 (n8)” has been 
registered as a remote device. Also, make sure 
that “n12 (n8) Remote” has been selected as the 
MIDI I/O ports.

• (Macintosh) When an external MIDI device is 
added to the device “mLAN Network” in the Audio 
MIDI Setup window (called up by selecting 
[Application] → [Utilities]), the MIDI input/output 
port for the remote device may not be set 
automatically in Cubase. In this case, remove all 
the external devices in the Audio MIDI Setup 
window, or manually set the MIDI input/output port 
for the remote device to the appropriate one in the 
Device Setup window in Cubase.

■ The [WET] switch does not respond. / Cannot 
monitor wet (effect) signals.
• Make sure that the CUBASE READY indicator is lit. 

If it is not lit, refer to the section “The CUBASE 
READY indicator does not turn on” above.

• Cubase projects must have an audio bus or track 
to be monitored. Create a bus or track manually, 
or use one of the n8/n12 project templates (see 
page 36).

■ Pressing a WORK MODE switch does not change 
the output destination of Cubase audio tracks.
• Make sure that the CUBASE READY indicator is lit. 

If it is not lit, refer to the section “The CUBASE 
READY indicator does not turn on” above.

• Cubase projects must have an audio bus or track 
to be monitored. Create a bus or track manually, 
or use an n8/n12 project template (see page 36).

■ Cannot find a n8/n12 project template.
• Make sure that the Extensions for Steinberg DAW 

software has been installed.
• If you install Cubase after you install Extensions for 

Steinberg DAW, the project template files will be 
installed in the following location. Copy these files 
to the location where Cubase has been installed.
Windows:
C:\Program Files\Steinberg\Cubase 4\templates
C:\Program Files\Steinberg\Cubase Studio 4\templates
C:\Program Files\Steinberg\Cubase AI 4\templates

Macintosh:
/Applications/Cubase 4.app/Contents/templates/
/Applications/Cubase Studio 4.app/Contents/templates/
/Applications/Cubase AI 4.app/Contents/templates/

■ Audio and MIDI signals fail to transfer between 
computer and mixer.
• The driver may not have been installed or set up 

correctly.
• Make sure that the IEEE 1394 cable is connected 

properly, and that the power to the n8/n12 has 
been turned on.

• There may be a loop connection. Check the 
cabling to make sure that none of the devices are 
connected in a loop.

• Make sure that the driver (Connection Manager) is 
enabled. (The driver icon should be blue.) 
(Windows) Right Click the driver icon on the task 
bar, then select [ON].
(Macintosh) Click the driver icon on the status 
menu, then select [Connection Manager] → [ON].

• (Windows) When you connect the n8/n12, make 
sure that the system displays a screen indicating 
that the connection is in progress. If not, right-click 
the driver icon on the task bar, then select RESET 
ALL to reset the connection. The connection 
process resumes from the beginning. (This 
connection screen is supposed to appear the first 
time you connect the n8/n12 to your computer. If 
you connect the n8/n12 to a computer, then later 
switch to another computer, and then connect it to 
the previous computer, this screen also appears.

• (Windows) There may be multiple IEEE 1394 
interfaces installed on the computer. In this case, 
follow the steps below to set the interface that is 
connected to the n8/n12.
(1) Right-click the driver icon on the task bar, 

then select [Driver Setup].
(2) Select the IEEE 1394 interface in “1394 

Adapter Card ID” that is connected to the n8/
n12.

(3) Re-insert the IEEE 1394 cable. 
(4) Right-click the driver icon on the task bar and 

select [OFF] to disable the driver.
(5) Right-click the driver icon again and select 

[ON] to enable the driver.
• (Windows) Try returning the settings to their 

default state by right-clicking the driver icon in the 
task bar and selecting [RESET ALL].

• (Macintosh) Use only the standard IEEE 1394 
(FireWire) interface of your computer and remove 
other IEEE 1394 interfaces since AI Driver 
supports only the standard interfaces.

n8/n12

n8/n12

: IEEE 1394-equipped device

computer computer

Example of loop connection
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■ The computer processing speed is too slow. / The 
computer’s CPU meter indicates a heavy 
processing load. / Playback response is delayed.
• Make sure that your computer satisfies the system 

requirements.
• Try increasing the latency value.
• If you will not be using the driver, you can reduce 

the load on the computer by disabling the driver. 
(Windows) Right-click the driver icon on the task 
bar then select [OFF].
(Macintosh) Click the driver icon on the status 
menu, then select [Connection Manager] → [OFF].

• (Windows) Refer to “Hints when using audio data” 
in the TOOLS for n/Cubase AI4 Installation Guide.

■ An application, such as a DAW, fails to recognize 
the driver (audio/MIDI).
• Make sure that the driver (Connection Manager) is 

enabled. 
(Windows) Right-click the driver icon on the task 
bar then select [ON].
(Macintosh) Click the driver icon on the status 
menu, then select [Connection Manager] → [ON].

• Are the other settings of the driver appropriate?

■ Recorded devices aren’t selected.
• Use an ASIO compatible application. Recording 

by other than ASIO-compatible application is not 
possible.

■ (Windows) Cannot change driver settings, such 
as sampling frequency. / Cannot disable the 
driver.
• If any application that uses the driver is running, 

quit the application, then try to change the driver 
settings.

■ (Windows) Cannot uninstall (remove) the driver.
• Right-click the driver icon on the task bar to 

display the pop-up menu, disable [Auto On] in the 
menu, and restart the computer. Then, try to 
uninstall the driver again.

■ Cannot use other connected Firewire devices 
correctly.
• Turn the driver (Connection Manager) off. 

(Windows) Right-click the driver icon on the task 
bar then select [OFF].
(Macintosh) Click the driver icon on the status 
menu, then select [Connection Manager] → [OFF].

■ The driver icon in the task bar/status menu has 
disappeared.
• Follow the steps below to start the driver.

(Windows) Select [Start] → [(All) Programs] → 
[Startup] or [mLANTools], then select mLAN 
Manager.
(Macintosh) From [Application] → [mLAN Tools] 
double-click [mLAN Manager].

• (Macintosh) Make sure that the latest version of 
the mLAN Tools has been installed. If so, install 
the TOOLS for n again.

■ Cannot use other connected IEEE1394-equipped 
devices correctly.
• Turn the driver (Connection Manager) off. 

(Windows) Right-clicking the driver icon on the 
task bar, then select [OFF].
(Macintosh) Click the driver icon on the status 
menu, then select [Connection Manager] → [OFF].
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Specifications

Electrical Specifications

Input and Output Specifications

Appendix

Sampling Frequency Internal 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz

External 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz (±0.1 %)

Total Harmonic Distortion GAIN: Minimum 0.003 % or less  (1 kHz @ +18 dB, into 600 Ω)

Frequency Response
(CH IN to STEREO OUT)

fs = 48 kHz 20 Hz–20 kHz,  +1, –3 dB @ +4 dB, into 600 Ω

fs = 96 kHz 20 Hz–40 kHz, +1, –3 dB @ +4 dB, into 600 Ω

Dynamic Range
(SN ratio at the maximum level)

114 dB, DA converter (STEREO OUT)

106 dB, AD + DA (to STEREO OUT)

Hum & Noise
(20 Hz–20 kHz)
Rs = 150 Ω

–128 dB, Equivalent input noise

–95 dB, Residual output noise, STEREO fader: Minimum

GAIN: Maximum
PAD: OFF

–95 dB (99 dB SN), STEREO OUT
STEREO fader: Nominal level, All channel faders: Minimum

GAIN: –60 dB
PAD: OFF

–60 dB (64 dB SN), STEREO OUT
STEREO fader: Nominal level, One channel fader: Nominal level

Maximum Voltage Gain n12 84 dB, CH1–8 to STEREO OUT/C-R OUT

50 dB, CH9–12 to STEREO OUT/C-R OUT

76 dB, CH1–8 to AUX OUT

42 dB, CH9–12 to AUX OUT

n8 76 dB, CH1–4 to STEREO OUT/C-R OUT

42 dB, CH5–8 to STEREO OUT/C-R OUT

Crosstalk @ 1 kHz GAIN: Minimum
Adjacent Input

n12 –86 dB, CH1–8

–80 dB, CH9–12

n8 –86 dB, CH1–4

–80 dB, CH5–8

Analog Input Type
Input Level

Nominal Level Maximum Level Input Impedance

INPUT A (Mono)
CH1–8 (n12)
CH1–4 (n8)

XLR type balanced, 
+48 V Phantom powered

–60 dBu to +10 dBu +24 dBu 3.5 kΩ

INPUT B (Mono)
CH1–8 (n12)
CH1–4 (n8)

TRS phone type, balanced –60 dBu to +10 dBu +24 dBu 3.5 kΩ 
(500 kΩ @ Hi-Z = ON)

INSERT IN TRS phone type, unbalanced 0 dBu +14 dBu 10 kΩ

INPUT (Stereo)
CH9–12 (n12)
CH5–8 (n8)

RCA pin type, unbalanced –40 dBV to –10 dBV +4 dBV 10 kΩ

Phone type, unbalanced –26 dBu to +4 dBu +18 dBu 10 kΩ

2TR IN RCA pin type, unbalanced –10 dBV +4 dBV 10 kΩ

Analog Output Type
Output Level

Nominal Level Maximum Level Input Impedance

ST OUT TRS phone type, balanced +4 dBu +18 dBu 600 Ω

RCA pin type, unbalanced –10 dBV +4 dBV 10 kΩ

C-R OUT TRS phone type, balanced +4 dBu +18 dBu 600 Ω

AUX OUT (Only n12) TRS phone type, balanced +4 dBu +18 dBu 600 Ω

INSERT OUT TRS phone type, unbalanced +4 dBu +18 dBu 10 kΩ

C-R PHONES, AUX PHONES TRS phone type, unbalanced 4 mW + 4 mW 25 mW + 25 mW 8 Ω

12 mW + 12 mW 75 mW + 75 mW 40 Ω
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General Specifications

Functions

Faders n12 100 mm × 11 (Non-motorized)

n8 60 mm × 7 (Non-motorized)

Power Requirements n12 51 W (PA-30)

n8 33 W (PA-20)

Dimensions (H × D × W) n12 146 × 561 × 515 mm

n8 146 × 518 × 368 mm

Net Weight n12 14 kg

n8 11 kg

Operating Free-air Temperature Range +5 to +35 ˚C

Included Accessories AC power adaptor (PA-30 (n12), PA-20 (n8))
DVD-ROM (Cubase AI4)
CD-ROM (TOOLS for n)
Owner’s Manual
TOOLS for n/Cubase AI4 Installation Guide
IEEE 1394 cable

Monaural Input Channels
CH1–8 (n12)
CH1–4 (n8)

To DIRECT OUT, REC bus, 
STEREO bus

Analog Input

MIC Preamp Discrete Class-A MIC preamp (Inverted Darlington Circuitry)

PHANTOM Switch +48 V DC (Only for INPUT A, turn on/off every 4 channels)

PAD Switch 0/26 dB

GAIN Control 44 dB variable (–60 dB to –16 dB)

PHASE Switch Normal/Reversed (CH1–7 (n12), CH1–3 (n8))

High Pass Filter Switch OFF/80 Hz (–12 dB/oct.)

Hi-Z Switch ON/OFF (CH8 (n12), CH4 (n8)), Input impedance: 500 kΩ

AD Converter 24 bit linear, Enhanced dual-bit delta-sigma conversion

Analog/DAW Input

INPUT SELECT Switch A.IN (analog)/DAW (IEEE1394 jack)

COMP LED Lights in red when the compressor is triggered.

MORPH Control Morphs between 5 Sweet Spot Data

DRIVE Control 128 resolution

Equalizer 3 band PEQ ±18 dB, MID frequency range: 100 Hz–10 kHz

ON Switch ON/OFF

REVERB Control Adjusts a post-fader signal after PAN

AUX Control Adjusts a pre-fader signal after PAN

PAN Control 33 resolution

SOLO Switch ON/OFF

DIRECT OUT Pre-fader

Input Meter LED × 4: OVER (red), –3 dB (amber), –14 dB (amber), –48 dB (green)

n12 Pre-fader/Post-fader

n8 Only pre-fader

WET Switch WET ON/OFF

Stereo Input Channels
CH9–12 (n12)
CH5–8 (n8)

To DIRECT OUT, REC bus, STEREO 
bus

Analog Input

GAIN Control 30 dB variable (–26 dB to +4 dB)

High Pass Filter Switch OFF/80 Hz (–12 dB/oct.)

AD Converter 24 bit linear, Enhanced dual-bit delta-sigma conversion

Analog/DAW Input

INPUT SELECT Switch A.IN (analog)/DAW (IEEE1394 jack)

Equalizer 3 band PEQ ±18 dB, MID frequency range: 100 Hz–10 kHz

ON Switch ON/OFF

REVERB Control Adjusts a post-fader signal after PAN

AUX Control Adjusts a pre-fader signal after PAN

BAL Control 33 resolution

SOLO Switch ON/OFF

DIRECT OUT Pre-fader

Input Meter LED × 4: OVER (red), –3 dB (amber), –14 dB (amber), –48 dB (green)

n12 Pre-fader/Post-fader

n8 Only pre-fader

WET Switch WET ON/OFF
Owner’s Manual



Appendix

En
gl

is
h

D
eu

ts
ch

Fr
an

ça
is

Es
pa

ño
l

European models
Purchaser/User Information specified in EN55103-1 and EN55103-2.
Inrush Current: 2.5 A (n12), 2 A (n8)
Conforms to Environments: E1, E2, E3, E4

Europäische Modelle
Käufer/Anwenderinformationen nach EN55103-1 und EN55103-2.
Einschaltstrom: 2.5 A (n12), 2 A (n8)
Einsatzbereiche: E1, E2, E3 und E4

Pour les modèles européens
Les informations acheteur/utilisateur sont spécifiées par les directives EN55103-1 et EN55103-2.
Courant d'appel : 2.5 A (n12), 2 A (n8)
Conformité aux normes environnementales : E1, E2, E3 et E4

Modelos europeos
Información comprador/usuario especificada en EN55103-1 y EN55103-2.
Intensidad de entrada: 2.5 A (n12), 2 A (n8)
Conforme para entornos: E1, E2, E3, E4

2TR IN

To C-R OUT, STEREO bus

LEVEL Control –∞ to +6 dB (to STEREO bus)/0 dB (to C-R)

ON Switch ON/OFF

AD Converter 24 bit linear, Enhanced dual-bit delta/sigma conversion

ST OUT

Outputs CH1–12, 2TR IN, DAW,  
REVERB, RETURN signals

STEREO Fader n12 –∞ to +10 dB

n8 –∞ to +6 dB

STEREO ON Switch ON/OFF

STEREO BAL Control 33 resolution

DA Converter 24 bit linear, 128 times oversampling advanced multi-bit delta/sigma 
conversion

C-R OUT

The BASS MANAGEMENT function 
works in the surround sound system 
(Only n12).

CONTROL ROOM LEVEL Control –∞ to 0 dB

C-R SPEAKER SELECT Switch n12 A (L/R), B (C/SW), C (LS/RS) Brackets (  ) indicate sources when 5.1 
is selected as C-R SOURCE SELECT.

C-R SOURCE SELECT Switch n12 5.1/DAW/STEREO bus/AUX bus/2TR IN

n8 DAW/STEREO bus/AUX bus/2TR IN

DOWN MIX Switch n12 ON/OFF (Active when 5.1 is selected as C-R SOURCE SELECT)

DIMMER Switch ON/OFF

MUTE Switch ON/OFF

TALKBACK Switch n12 ON/OFF

TALK BACK LEVEL Control n12 –∞ to +6 dB, Sensitivity: –40 dB

PFL Switch ON (SOLO: Pre-fader)/OFF (SOLO: Post-fader)

DA Converter 24 bit linear, 128 times oversampling Advanced multi-bit delta/sigma 
conversion

AUX OUT (Only n12)

Outputs CH1-12, DAW, REVERB 
Return, TALK BACK signals

AUX LEVEL Control –∞ to +6 dB (to AUX bus), –∞ to +6 dB (AUX bus to AUX OUT)

DA Converter 24 bit linear, 128 times oversampling (@ fs = 44.1 kHz, 48 kHz), 64 
times oversampling (@ fs = 88.2 kHz, 96 kHz) advanced multi-bit 
delta-sigma conversion

PHONES (AUX, C-R) LEVEL control for each AUX and C-R jacks

Maximum Output Level 25 mW (@ 8 Ω)/75 mW (@ 40 Ω)

DAW I/O Audio I/F n12 16-ch input/16-ch output

n8 12-ch input/12-ch output

MIDI  I/F 2-port input/2-port output
(DAW remote control, Input/Output via MIDI IN/OUT jacks)

MIDI IN/OUT 1 port input/1port output

Output Level Meter MASTER LEVEL METER n12 12 points LED meter × 6

n8 12 points LED meter × 2

METER SELECT Switch C-R level/Bus level

Reverb

To AUX bus, REC bus, STEREO bus

Type HALL/ROOM/PLATE

Control REVERB TIME, LEVEL

DAW Remote Control WORK MODE ST MIX/HARDWARE MIX/5.1 MIX (5.1 MIX is only for n12.)

MONITOR REMOTE Recording monitor: ON/OFF, VST effects (WET): ON/OFF

CLICK REMOTE Click ON/OFF, CLICK LEVEL control

TRACK CONTROL PREV, NEXT, REC READY switch

TRANSPORT CYCLE, Previous Marker, Add Marker, Next Marker, REW, FWD, 
STOP, PLAY, REC switch
Owner’s Manual 59
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Bus connections of n8/n12 and DAW

Cubase 4/Cubase Studio 4/Cubase AI4
By installing “Extensions for Steinberg DAW” and using the templates, the input/output buses in Cubase are assigned 
to the device as follows.

Cubase Output
n12 Input n12 Output

Cubase Input

Output Bus Device Port Device Port Input Bus

n12-L/R n12-5.1 n12 Monitor L → DAW TO ST-L 5.1(L) CH1 Direct Out → n12 Direct Out 1 n12-Dir1

n12 Monitor R → DAW TO ST-R 5.1(R) CH2 Direct Out → n12 Direct Out 2 n12-Dir2

n12-9/10 n12 Monitor 9/C → Input Channel 9 5.1(C) CH3 Direct Out → n12 Direct Out 3 n12-Dir3

n12 Monitor 10/LFE → Input Channel 10 5.1(LFE) CH4 Direct Out → n12 Direct Out 4 n12-Dir4

n12-11/12 n12 Monitor 11/Ls → Input Channel 11 5.1(Ls) CH5 Direct Out → n12 Direct Out 5 n12-Dir5

n12 Monitor 12/Rs → Input Channel 12 5.1(Rs) CH6 Direct Out → n12 Direct Out 6 n12-Dir6

n12-1 n12 input 1 → Input Channel 1 CH7 Direct Out → n12 Direct Out 7 n12-Dir7

n12-2 n12 input 2 → Input Channel 2 CH8 Direct Out → n12 Direct Out 8 n12-Dir8

n12-3 n12 input 3 → Input Channel 3 CH9 Direct Out → n12 Direct Out 9 n12-Dir9/10

n12-4 n12 input 4 → Input Channel 4 CH10 Direct Out → n12 Direct Out 10

n12-5 n12 input 5 → Input Channel 5 CH11 Direct Out → n12 Direct Out 11 n12-Dir11/12

n12-6 n12 input 6 → Input Channel 6 CH12 Direct Out → n12 Direct Out 12

n12-7 n12 input 7 → Input Channel 7 REC BUS L → n12 REC Bus L n12-REC

n12-8 n12 input 8 → Input Channel 8 REC BUS R → n12 REC Bus R

n12-AUX n12 AUX L → DAW TO AUX-L STEREO BUS L → n12 ST Bus L n12-ST

n12 AUX R → DAW TO AUX-R STEREO BUS R → n12 ST Bus R

Cubase Output
n8 Input n8 Output

Cubase Input

Output Bus Device Port Device Port Input Bus

n8-L/R n8 Monitor L → DAW TO ST-L CH1 Direct Out → n8 Direct Out 1 n8-Dir1

n8 Monitor R → DAW TO ST-R CH2 Direct Out → n8 Direct Out 2 n8-Dir2

n8-5/6 n8 input 5 → Input Channel 5 CH3 Direct Out → n8 Direct Out 3 n8-Dir3

n8 input 6 → Input Channel 6 CH4 Direct Out → n8 Direct Out 4 n8-Dir4

n8-7/8 n8 input 7 → Input Channel 7 CH5 Direct Out → n8 Direct Out 5 n8-Dir5/6

n8 input 8 → Input Channel 8 CH6 Direct Out → n8 Direct Out 6

n8-1 n8 input 1 → Input Channel 1 CH7 Direct Out → n8 Direct Out 7 n8-Dir7/8

n8-2 n8 input 2 → Input Channel 2 CH8 Direct Out → n8 Direct Out 8

n8-3 n8 input 3 → Input Channel 3 REC BUS L → n8 REC Bus L n8-REC

n8-4 n8 input 4 → Input Channel 4 REC BUS R → n8 REC Bus R

n8-AUX n8 AUX L → DAW TO AUX-L STEREO BUS L → n8 ST Bus L n8-ST

n8 AUX R → DAW TO AUX-R STEREO BUS R → n8 ST Bus R
Owner’s Manual
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Other Applications
■ Windows (SONAR 5/Windows Media Player):

ASIO Driver

WDM Driver

Output Device Port n12 Input n12 Output Input Device Port

ASIO mLAN mLAN01 → DAW TO ST-L 5.1(L) CH1 Direct Out → ASIO mLAN mLAN01

ASIO mLAN mLAN02 → DAW TO ST-R 5.1(R) CH2 Direct Out → ASIO mLAN mLAN02

ASIO mLAN mLAN03 → Input Channel 9 5.1(C) CH3 Direct Out → ASIO mLAN mLAN03

ASIO mLAN mLAN04 → Input Channel 10 5.1(LFE) CH4 Direct Out → ASIO mLAN mLAN04

ASIO mLAN mLAN05 → Input Channel 11 5.1(Ls) CH5 Direct Out → ASIO mLAN mLAN05

ASIO mLAN mLAN06 → Input Channel 12 5.1(Rs) CH6 Direct Out → ASIO mLAN mLAN06

ASIO mLAN mLAN07 → Input Channel 1 CH7 Direct Out → ASIO mLAN mLAN07

ASIO mLAN mLAN08 → Input Channel 2 CH8 Direct Out → ASIO mLAN mLAN08

ASIO mLAN mLAN09 → Input Channel 3 CH9 Direct Out → ASIO mLAN mLAN09

ASIO mLAN mLAN10 → Input Channel 4 CH10 Direct Out → ASIO mLAN mLAN10

ASIO mLAN mLAN11 → Input Channel 5 CH11 Direct Out → ASIO mLAN mLAN11

ASIO mLAN mLAN12 → Input Channel 6 CH12 Direct Out → ASIO mLAN mLAN12

ASIO mLAN mLAN13 → Input Channel 7 REC BUS L → ASIO mLAN mLAN13

ASIO mLAN mLAN14 → Input Channel 8 REC BUS R → ASIO mLAN mLAN14

ASIO mLAN mLAN15 → DAW TO AUX-L STEREO BUS L → ASIO mLAN mLAN15

ASIO mLAN mLAN16 → DAW TO AUX-R STEREO BUS R → ASIO mLAN mLAN16

Output Device Port n8 Input n8 Output Input Device Port

ASIO mLAN mLAN01 → DAW TO ST-L CH1 Direct Out → ASIO mLAN mLAN01

ASIO mLAN mLAN02 → DAW TO ST-R CH2 Direct Out → ASIO mLAN mLAN02

ASIO mLAN mLAN03 → Input Channel 5 CH3 Direct Out → ASIO mLAN mLAN03

ASIO mLAN mLAN04 → Input Channel 6 CH4 Direct Out → ASIO mLAN mLAN04

ASIO mLAN mLAN05 → Input Channel 7 CH5 Direct Out → ASIO mLAN mLAN05

ASIO mLAN mLAN06 → Input Channel 8 CH6 Direct Out → ASIO mLAN mLAN06

ASIO mLAN mLAN07 → Input Channel 1 CH7 Direct Out → ASIO mLAN mLAN07

ASIO mLAN mLAN08 → Input Channel 2 CH8 Direct Out → ASIO mLAN mLAN08

ASIO mLAN mLAN09 → Input Channel 3 REC BUS L → ASIO mLAN mLAN09

ASIO mLAN mLAN10 → Input Channel 4 REC BUS R → ASIO mLAN mLAN10

ASIO mLAN mLAN11 → DAW TO AUX-L STEREO BUS L → ASIO mLAN mLAN11

ASIO mLAN mLAN12 → DAW TO AUX-R STEREO BUS R → ASIO mLAN mLAN12

Output Device Port n12 Input

mLAN Audio Out 1/2 → DAW TO ST-L/R 5.1(L)/5.1(R)

mLAN Audio Out 3/4 → Input Channel 9/10 5.1(C)/5.1(LFE)

mLAN Audio Out 5/6 → Input Channel 11/12 5.1(Ls)/5.1(Rs)

mLAN Audio Out 7/8 → Input Channel 1/2

Output Device Port n8 Input

mLAN Audio Out 1/2 → DAW TO ST-L/R

mLAN Audio Out 3/4 → Input Channel 5/6

mLAN Audio Out 5/6 → Input Channel 7/8

mLAN Audio Out 7/8 → Input Channel 1/2
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■ Macintosh (Logic Pro7/D.P.5):

Logic Pro7

D.P.5

Output Device Port n12 Input n12 Output Input Device Port

Output 1 → DAW TO ST-L 5.1(L) CH1 Direct Out → Input 1

Output 2 → DAW TO ST-R 5.1(R) CH2 Direct Out → Input 2

Output 3 → Input Channel 9 5.1(C) CH3 Direct Out → Input 3

Output 4 → Input Channel 10 5.1(LFE) CH4 Direct Out → Input 4

Output 5 → Input Channel 11 5.1(Ls) CH5 Direct Out → Input 5

Output 6 → Input Channel 12 5.1(Rs) CH6 Direct Out → Input 6

Output 7 → Input Channel 1 CH7 Direct Out → Input 7

Output 8 → Input Channel 2 CH8 Direct Out → Input 8

Output 9 → Input Channel 3 CH9 Direct Out → Input 9

Output 10 → Input Channel 4 CH10 Direct Out → Input10

Output 11 → Input Channel 5 CH11 Direct Out → Input11

Output 12 → Input Channel 6 CH12 Direct Out → Input12

Output 13 → Input Channel 7 REC BUS L → Input13

Output 14 → Input Channel 8 REC BUS R → Input14

Output 15 → DAW TO AUX-L STEREO BUS L → Input15

Output 16 → DAW TO AUX-R STEREO BUS R → Input16

Output Device Port n8 Input n8 Output Input Device Port

Output 1 → DAW TO ST-L CH1 Direct Out → Input 1

Output 2 → DAW TO ST-R CH2 Direct Out → Input 2

Output 3 → Input Channel 5 CH3 Direct Out → Input 3

Output 4 → Input Channel 6 CH4 Direct Out → Input 4

Output 5 → Input Channel 7 CH5 Direct Out → Input 5

Output 6 → Input Channel 8 CH6 Direct Out → Input 6

Output 7 → Input Channel 1 CH7 Direct Out → Input 7

Output 8 → Input Channel 2 CH8 Direct Out → Input 8

Output 9 → Input Channel 3 REC BUS L → Input 9

Output10 → Input Channel 4 REC BUS R → Input10

Output11 → DAW TO AUX-L STEREO BUS L → Input11

Output12 → DAW TO AUX-R STEREO BUS R → Input12

Output Device Port n12 Input n12 Output Input Device Port

mLAN Network:Audio In1 1 → DAW TO ST-L 5.1(L) CH1 Direct Out → mLAN Network:Audio Out 1 1

mLAN Network:Audio In2 2 → DAW TO ST-R 5.1(R) CH2 Direct Out → mLAN Network:Audio Out 2 2

mLAN Network:Audio In3 3 → Input Channel 9 5.1(C) CH3 Direct Out → mLAN Network:Audio Out 3 3

mLAN Network:Audio In4 4 → Input Channel 10 5.1(LFE) CH4 Direct Out → mLAN Network:Audio Out 4 4

mLAN Network:Audio In5 5 → Input Channel 11 5.1(Ls) CH5 Direct Out → mLAN Network:Audio Out 5 5

mLAN Network:Audio In6 6 → Input Channel 12 5.1(Rs) CH6 Direct Out → mLAN Network:Audio Out 6 6

mLAN Network:Audio In7 7 → Input Channel 1 CH7 Direct Out → mLAN Network:Audio Out 7 7

mLAN Network:Audio In8 8 → Input Channel 2 CH8 Direct Out → mLAN Network:Audio Out 8 8

mLAN Network:Audio In9 9 → Input Channel 3 CH9 Direct Out → mLAN Network:Audio Out 9 9

mLAN Network:Audio In10 10 → Input Channel 4 CH10 Direct Out → mLAN Network:Audio Out10 10

mLAN Network:Audio In11 11 → Input Channel 5 CH11 Direct Out → mLAN Network:Audio Out11 11

mLAN Network:Audio In12 12 → Input Channel 6 CH12 Direct Out → mLAN Network:Audio Out12 12

mLAN Network:Audio In13 13 → Input Channel 7 REC BUS L → mLAN Network:Audio Out13 13

mLAN Network:Audio In14 14 → Input Channel 8 REC BUS R → mLAN Network:Audio Out14 14

mLAN Network:Audio In15 15 → DAW TO AUX-L STEREO BUS L → mLAN Network:Audio Out15 15

mLAN Network:Audio In16 16 → DAW TO AUX-R STEREO BUS R → mLAN Network:Audio Out16 16

Output Device Port n8 Input n8 Output Input Device Port

mLAN Network:Audio In1 1 → DAW TO ST-L CH1 Direct Out → mLAN Network:Audio Out 1 1

mLAN Network:Audio In2 2 → DAW TO ST-R CH2 Direct Out → mLAN Network:Audio Out 2 2

mLAN Network:Audio In3 3 → Input Channel 5 CH3 Direct Out → mLAN Network:Audio Out 3 3

mLAN Network:Audio In4 4 → Input Channel 6 CH4 Direct Out → mLAN Network:Audio Out 4 4

mLAN Network:Audio In5 5 → Input Channel 7 CH5 Direct Out → mLAN Network:Audio Out 5 5

mLAN Network:Audio In6 6 → Input Channel 8 CH6 Direct Out → mLAN Network:Audio Out 6 6

mLAN Network:Audio In7 7 → Input Channel 1 CH7 Direct Out → mLAN Network:Audio Out 7 7

mLAN Network:Audio In8 8 → Input Channel 2 CH8 Direct Out → mLAN Network:Audio Out 8 8

mLAN Network:Audio In9 9 → Input Channel 3 REC BUS L → mLAN Network:Audio Out 9 9

mLAN Network:Audio In10 10 → Input Channel 4 REC BUS R → mLAN Network:Audio Out10 10

mLAN Network:Audio In11 11 → DAW TO AUX-L STEREO BUS L → mLAN Network:Audio Out11 11

mLAN Network:Audio In12 12 → DAW TO AUX-R STEREO BUS R → mLAN Network:Audio Out12 12
Owner’s Manual
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Dimensional Diagrams
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MIDI Implementation Chart

Note 
Number : True voice **************

x *1 x *1
x

 YAMAHA [ DIGITAL MIXING STUDIO ] Date :5-Oct-2006
Model n8/12 MIDI Implementation Chart Version :1.0

Function... Transmitted Recognized Remarks

Basic Default

Channel Changed

x x

xx

DefaultMode

Messages

Altered

x

x

**************

x

x

x

Velocity Note ON

Note OFF

x 

x 

x 

x 

After
Touch

Key's

Ch's

x    

x

x

x

Pitch Bend x    x

Control 
Change

0-121 x x

Prog
Change : True #

x x

x**************

System Exclusive x *1 x *1

Common  : Song Pos.

: Song Sel.

: Tune

x

x

x

x

x

x

System
Real Time

: Clock

: Commands

x

x

x

x

: Reset All Cntrls
: All Sound Off x

x
x
x

Notes: Used only for the communication with DAW.*1

The MIDI Port is used as an extended port for DAW.    

Mode 1 : OMNI ON, POLY Mode 2 : OMNI ON, MONO o : Yes
Mode 3 : OMNI OFF, POLY Mode 4 : OMNI OFF, MONO x : No 

Aux 
Messages

: Local ON/OFF
: All Notes OFF
: Active Sense
: Reset

x
x
x
x

x
x
x
x
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o el distribuidor autorizado que se lista debajo.

CANADA
Yamaha Canada Music Ltd.
135 Milner Avenue, Scarborough, Ontario,
M1S 3R1, Canada
Tel: 416-298-1311

U.S.A.
Yamaha Corporation of America 
6600 Orangethorpe Ave., Buena Park, Calif. 90620, 
U.S.A.
Tel: 714-522-9011

MEXICO
Yamaha de México S.A. de C.V.
Calz. Javier Rojo Gómez #1149,
Col. Guadalupe del Moral
C.P. 09300, México, D.F., México
Tel: 55-5804-0600 

BRAZIL
Yamaha Musical do Brasil Ltda.
Rua Joaquim Floriano, 913 - 4' andar, Itaim Bibi, 
CEP 04534-013 Sao Paulo, SP. BRAZIL
Tel: 011-3704-1377

ARGENTINA
Yamaha Music Latin America, S.A. 
Sucursal de Argentina
Viamonte 1145 Piso2-B 1053, 
Buenos Aires, Argentina
Tel: 1-4371-7021

PANAMA AND OTHER LATIN 
AMERICAN COUNTRIES/
CARIBBEAN COUNTRIES 

Yamaha Music Latin America, S.A.
Torre Banco General, Piso 7, Urbanización Marbella, 
Calle 47 y Aquilino de la Guardia, 
Ciudad de Panamá, Panamá 
Tel: +507-269-5311

THE UNITED KINGDOM
Yamaha-Kemble Music (U.K.) Ltd.
Sherbourne Drive, Tilbrook, Milton Keynes, 
MK7 8BL, England
Tel: 01908-366700

IRELAND
Danfay Ltd.
61D, Sallynoggin Road, Dun Laoghaire, Co. Dublin
Tel: 01-2859177

GERMANY
Yamaha Music Central Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

SWITZERLAND/LIECHTENSTEIN
Yamaha Music Central Europe GmbH, 
Branch Switzerland
Seefeldstrasse 94, 8008 Zürich, Switzerland
Tel: 01-383 3990

AUSTRIA
Yamaha Music Central Europe GmbH, 
Branch Austria
Schleiergasse 20, A-1100 Wien, Austria
Tel: 01-60203900

CZECH REPUBLIC/SLOVAKIA/
HUNGARY/SLOVENIA

Yamaha Music Central Europe GmbH, 
Branch Austria, CEE Department
Schleiergasse 20, A-1100 Wien, Austria 
Tel: 01-602039025

POLAND
Yamaha Music Central Europe GmbH 
Sp.z. o.o. Oddzial w Polsce
ul. 17 Stycznia 56, PL-02-146 Warszawa, Poland
Tel: 022-868-07-57

THE NETHERLANDS/
BELGIUM/LUXEMBOURG

Yamaha Music Central Europe GmbH, 
Branch Benelux 
Clarissenhof 5-b, 4133 AB Vianen, The Netherlands 
Tel: 0347-358 040 

FRANCE
Yamaha Musique France 
BP 70-77312 Marne-la-Vallée Cedex 2, France
Tel: 01-64-61-4000

ITALY
Yamaha Musica Italia S.P.A. 
Combo Division
Viale Italia 88, 20020 Lainate (Milano), Italy 
Tel: 02-935-771

SPAIN/PORTUGAL
Yamaha-Hazen Música, S.A.
Ctra. de la Coruna km. 17, 200, 28230 
Las Rozas (Madrid), Spain
Tel: 91-639-8888

GREECE
Philippos Nakas S.A. The Music House
147 Skiathou Street, 112-55 Athens, Greece
Tel: 01-228 2160

SWEDEN
Yamaha Scandinavia AB
J. A. Wettergrens Gata 1
Box 30053
S-400 43 Göteborg, Sweden
Tel: 031 89 34 00

DENMARK
YS Copenhagen Liaison Office
Generatorvej 6A 
DK-2730 Herlev, Denmark
Tel: 44 92 49 00

FINLAND
F-Musiikki Oy
Kluuvikatu 6, P.O. Box 260, 
SF-00101 Helsinki, Finland
Tel: 09 618511

NORWAY
Norsk filial av Yamaha Scandinavia AB 
Grini Næringspark 1
N-1345 Østerås, Norway 
Tel: 67 16 77 70

ICELAND
Skifan HF
Skeifan 17 P.O. Box 8120
IS-128 Reykjavik, Iceland
Tel: 525 5000

OTHER EUROPEAN COUNTRIES
Yamaha Music Central Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: +49-4101-3030

Yamaha Corporation, 
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2312

TURKEY/CYPRUS
Yamaha Music Central Europe GmbH
Siemensstraße 22-34, 25462 Rellingen, Germany
Tel: 04101-3030

OTHER COUNTRIES
Yamaha Music Gulf FZE
LOB 16-513, P.O.Box 17328, Jubel Ali, 
Dubai, United Arab Emirates
Tel: +971-4-881-5868

THE PEOPLE’S REPUBLIC OF CHINA
Yamaha Music & Electronics (China) Co.,Ltd.
25/F., United Plaza, 1468 Nanjing Road (West),
Jingan, Shanghai, China
Tel: 021-6247-2211

HONG KONG
Tom Lee Music Co., Ltd.
11/F., Silvercord Tower 1, 30 Canton Road,
Tsimshatsui, Kowloon, Hong Kong
Tel: 2737-7688

INDONESIA
PT. Yamaha Music Indonesia (Distributor)
PT. Nusantik
Gedung Yamaha Music Center, Jalan Jend. Gatot 
Subroto Kav. 4, Jakarta 12930, Indonesia
Tel: 21-520-2577

KOREA
Yamaha Music Korea Ltd.
8F, 9F, Dongsung Bldg. 158-9 Samsung-Dong,  
Kangnam-Gu, Seoul, Korea
Tel: 080-004-0022

MALAYSIA
Yamaha Music Malaysia, Sdn., Bhd.
Lot 8, Jalan Perbandaran, 47301 Kelana Jaya, 
Petaling Jaya, Selangor, Malaysia
Tel: 3-78030900

PHILIPPINES
Yupangco Music Corporation
339 Gil J. Puyat Avenue, P.O. Box 885 MCPO, 
Makati, Metro Manila, Philippines
Tel: 819-7551 

SINGAPORE
Yamaha Music Asia Pte., Ltd.
#03-11 A-Z Building
140 Paya Lebor Road, Singapore 409015
Tel: 747-4374

TAIWAN
Yamaha KHS Music Co., Ltd. 
3F, #6, Sec.2, Nan Jing E. Rd. Taipei.
Taiwan 104, R.O.C.
Tel: 02-2511-8688

THAILAND
Siam Music Yamaha Co., Ltd.
891/1 Siam Motors Building, 15-16 floor
Rama 1 road, Wangmai, Pathumwan
Bangkok 10330, Thailand
Tel: 02-215-2626

OTHER ASIAN COUNTRIES 
Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2317

AUSTRALIA
Yamaha Music Australia Pty. Ltd.
Level 1, 99 Queensbridge Street, Southbank, 
Victoria 3006, Australia
Tel: 3-9693-5111

NEW ZEALAND
Music Houses of N.Z. Ltd.
146/148 Captain Springs Road, Te Papapa, 
Auckland, New Zealand
Tel: 9-634-0099

COUNTRIES AND TRUST 
TERRITORIES IN PACIFIC OCEAN

Yamaha Corporation,
Asia-Pacific Music Marketing Group
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, 
Japan 430-8650
Tel: +81-53-460-2312

NORTH AMERICA

CENTRAL & SOUTH AMERICA

EUROPE

AFRICA

MIDDLE EAST

ASIA

OCEANIA

HEAD OFFICE Yamaha Corporation, Pro Audio & Digital Musical Instrument Division
Nakazawa-cho 10-1, Naka-ku, Hamamatsu, Japan 430-8650
Tel: +81-53-460-2445
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